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BỘ 10 ĐỀ KIỂM TRA 1 TIẾT HỌC KÌ 1 MÔN TIN HỌC 12 NĂM 

HỌC 2019-2020 CÓ ĐÁP ÁN CHI TIẾT 

 

1. Đề kiểm tra 1 tiết HK1 môn Tin học 12 – Số 1 

TRƯỜNG THPT NGUYỄN DU ĐỀ KIỂM TRA 1 TIẾT HỌC KÌ 1 

MÔN TIN HỌC 12 

NĂM HỌC 2019-2020 

Thời gian làm bài: 45 phút 

Câu 1: Khi tạo cấu trúc bảng, tên trường được nhập vào cột. 

A. Field name.    

B. Data type 

C. Field size    

D.  Format 

Câu 2: Mỗi đối tượng của Access có các chế độ làm việc là: 

A. Thiết kế và cập nhật   B. Trang dữ liệu và thiết kế 

C. Thiết kế và bảng    D. Chỉnh sửa và cập nhật 

Câu 3: Trong CSDL đang làm việc, để tạo một bảng mới bằng cách tự thiết kế, thì thao tác 

thực hiện nào sau đây là đúng. 

A. Table – Create Table in design view  B. Query – Create Query in design view 

C. Form – Create Form in design view  D. Report – Create Report in design view 

Câu 4: Trong CSDL đang làm việc, để tạo một biểu mẫu  mới bằng cách làm theo trình thuật 

sĩ , thì thao tác thực hiện nào sau đây là đúng. 

A. Table – Create Table by using wizard  B. Query – Create Query by using wizard 

C. Form – Create Form by using wizard  D. Report – Create Report by using wizard 

Câu 5: Dữ liệu của CSDL được lưu trữ ở 

A. Query    B. Form 

C. Table    D. Report 

Câu 6: Dữ liệu kiểu logic trong Microsoft Access được ký hiệu là: 

A. Autonumber   B. Text 

C. Yes/No    D. Number 

Câu 7: Khi làm việc với bảng. Ở chế độ Design, khi thực hiện thao tác lệnh Insert Row là ta 

đang thực hiện công việc nào sau đây? 

A. Chèn thêm bảng   B. Chèn thêm cột 
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C. Chèn thêm bản ghi  D. Chèn thêm trường 

Câu 8: Sau khi thiết kế bảng, nếu ta không chọn khóa cho bảng thì 

A. Access tự động tạo khóa chính cho bảng   B. Access không cho lưu 

C. Access không cho nhập dữ liệu    D. Thoát khỏi Access. 

Câu 9: Phần mở rộng của các tệp được tạo bởi Microsoft Access là 

A. XLS   B. DOC 

C. MDB   D. PAS 

Câu 10: Truy vấn dữ liệu có nghĩa là 

A. Xóa các dữ liệu không cần đến nữa   B. Cập nhật dữ liệu 

C. Tìm kiếm và hiển thị dữ liệu    D. In dữ liệu. 

Câu 11: Bảng đã được hiển thị ở chế độ thiết kế, muốn đặt khóa chính ta thực hiện thao 

tác 

A. Edit – Primary key   B. File – Primary key 

C. Tools – Primary key   D. Windows – Primary key 

Câu 12: Để thực hiện liên kết dữ liệu ta chọn thao tác nào sau đây 

A. Tools – Relationships   B. Insert – Relationships 

C. Edit – Relationships   D. File – Relationships 

Câu 13: Trong các chức năng sau, chức năng nào không phải là chức năng của hệ quản trị 

CSDL. 

A. Cung cấp cách tạo lập CSDL 

B. Cung cấp cách quản lý tệp 

C. Cung cấp cách cập nhật, tìm kiếm và kết xuất thông tin 

D. Cung cấp công cụ kiểm soát việc truy cập vào CSDL 

Câu 14: Khi làm việc với bảng, ở chế độ Data sheet, khi thực hiện thao tác lệnh Insert 

/Columns là ta đang thực hiện công việc nào sau đây? 

A. Chèn thêm dòng     B. Chèn thêm cột 

C. Chèn thêm bản ghi    D. Chèn thêm trường 

Câu 15: Trong Microsoft Access, một CSDL thường là  

A. Một tệp      B. Tập hợp các bảng có liên quan với nhau 

C. Một sản phẩm phần mềm   D. Một văn bản. 

Câu 16: Độ rộng của trường có thể được thay đổi ở đâu 

A. Trong chế độ thiết kế    B. Trong chế độ trang dữ liệu 

C. Không thể thay đổi được   D. Có thể thay đổi bất cứ ở đâu. 

Câu 17: Các đối tượng cơ bản trong Access là: 
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A. Bảng, Macro, Biểu mẫu, Mẫu hỏi.   B. Bảng, Macro, Biểu mẫu, Báo cáo. 

C. Bảng, Mẫu hỏi, Biểu mẫu, Báo cáo   D. Bảng, Macro, Môđun, Báo cáo. 

Câu 18: Đối tượng nào không dùng để cập nhật dữ liệu: 

A. Báo cáo;   B. Bảng; 

C. Biểu mẫu;   D. Mẫu hỏi; 

Câu 19: Hệ quản trị CSDL là: 

A. Phần mềm dùng tạo lập, lưu trữ và khai thác một CSDL. 

B. Phần mềm dùng tạo lập CSDL. 

C. Phần mềm để thao tác và xử lý các đối tượng trong CSDL. 

D. Phần mềm dùng tạo lập, lưu trữ một CSDL 

Câu 20: Điều kiện để tạo mối liên kết giữa hai bảng là : 

A. Trường liên kết của hai bảng phải cùng kiểu dữ liệu 

B. Trường liên kết của hai bảng phải là chữ hoa 

C. Trường liên kết của hai bảng phải là kiểu dữ liệu số 

D. Trường liên kết của hai bảng phải khác nhau về kiểu dữ liệu 

Câu 21: Trong Access, ta có thể sử dụng biểu mẫu để : 

A. Nhập dữ liệu   B. Sửa cấu trúc bảng 

C. Lập báo cáo   D. Tính toán cho các trường tính toán 

Câu 22: Trên Table ở chế độ Design, thao tác chọn Edit  Delete Rows?  

A. Hủy khoá chính cho trường hiện tại.  B. Xoá trường hiện tại 

C. Tạo khoá chính cho trường hiện tại  D. Thêm trường mới vào trên trường hiện 

tại 

Câu 23: Khi một Field trên Table được chọn làm khoá chính thì? 

A. Giá trị dữ liệu trên Field đó được trùng nhau 

B. Giá trị dữ liệu trên Field đó không được trùng nhau 

C. Giá trị dữ liệu trên Field đó bắt buộc là kiểu Text 

D. Không có khái niệm khoá chính 

Câu 24: Trên Table ở chế độ Datasheet View, biểu tượng  trên thanh công cụ? 

A. Lọc theo ô dữ liệu đang chọn 

B. Huỷ bỏ lọc 

C. Lưu (Save) lại nội dung sau khi lọc 

D. Lọc dữ liệu theo mẫu 

Câu 25: Trên Table ở chế độ Datasheet View, Nhấn Ctrl+F? 

http://www.elib.vn/


    Website: www.eLib.vn  | Facebook: eLib.vn 
 

eLib.vn: Thư viện trực tuyến miễn phí 4 

 

A. Mở hộp thoại Font    B. Mở hộp thoại Relationships 

C. Mở hộp thoại Edit Relationships  D. Mở hộp thoại Find and Replace 

Câu 26: Trên Table ở chế độ Datasheet View, biểu tượng    trên thanh công cụ? 

A. Lọc dữ liệu theo mẫu 

B. Huỷ bỏ lọc 

C. Lọc theo ô dữ liệu đang chọn 

D. Lưu (Save) lại nội dung sau khi lọc 

Câu 27: Trong bảng chọn objects. Ngăn Table, thao tác Right/click  tên table, chọn 

Delete?  

A. Đổi tên table     

B. Tạo cấu trúc mới cho table  

C. Xoá table     

D. Lưu cấu trúc của table 

Câu 28: Trên Table ở chế độ Datasheet View, chọn một ô, chọn          ? 

A. Sắp xếp dữ liệu trên cột chứa ô vừa chọn theo chiều giảm 

B. Sắp xếp dữ liệu trên cột chứa ô vừa chọn theo chiều tăng 

C. Sắp xếp các trường của Table theo chiều tăng 

D. Sắp xếp các trường của Table theo chiều giảm 

Câu 29:Trong bảng chọn objects. Ngăn Table, thao tác Right/clicktên table, chọn 

Rename? 

A. Đổi tên table vừa chọn    

B. Nhập dữ liệu cho table 

C. Xoá table     

D. Chỉnh sửa cấu trúc cho table 

Câu 30: Trên Table ở chế độ Datasheet View, chọn Edit  Delete Record  Yes? 

A. Xoá trường khoá chính (Primary key)   B. Xoá Table đang xử lý 

C. Xoá trường chứa con trỏ    D. Xoá bản ghi chứa con trỏ 

Câu 31: Trong Access, để làm việc với chế độ thiết kế ta thực hiện: ……Design View? 

A. View B. Edit C. Insert D. Tools 

Câu 32: Trong Access, nút lệnh này  có ý nghĩa gì? 

A. Một tệp cơ sở dữ liệu B. Khởi động Access 

C. Xác định khóa chính D. Cài mật khaaurcho tệp cơ sở dữ liệu 
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Câu 33: Trong Access, kiểu dữ liệu số được khai báo bằng từ? 

A. Text B. Memo C. Curency D. Number 

Câu 34: Khi đang làm việc với cấu trúc bảng, muốn lưu cấu trúc vào đĩa, ta thực hiện: 

A. Tools / Save B. View / Save C. File / Save D. Format / Save 

Câu 35: Khi lám việc với Access xong, muốn thoát khỏi Access, ta thực hiện: 

A. Tools / Exit. B. File / Exit C. Windows /Exit D. View / Exit 

Câu 36: Trong Access, để định dạng lại lề trang dữ liệu, ta thực hiện: 

A. Format / Page Setup B. Tools / Page Setup 

C. Record / Page Setup D. File  / Page Setup 

Câu 37: Để thiết kế bảng theo ý thích của mình, sau khi vào hộp thoại New Table, ta chọn: 

A..Open Table. B. Design View C. DataSheet view D. Table Wizard 

Câu 38: Trong khi nhập dữ liệu cho bảng, muốn xóa một bản ghi đã được lựa chọn, ta bấm 

phím: 

A. Delete B. Tab C. Space D. Enter 

Câu 39: Sau khi thiết kế xong bảng nếu ta không chỉ định khóa chính thì 

A.  Access không cho phép nhập dữ liệu  

B.  Access không cho phép lưu bảng  

C.  Access chọn trường đầu tiên mà người thiết kế đã tạo làm khóa chính  

D.  Access đưa ra lựa chọn là tự động cho trường khóa chính cho bảng 

Câu 40: Để đi đến ô cuố cùng của bảng ở chế độ trang dữ liệu là nhấn phím: 

A.  End  B.  Shift + End C.  Ctrl + End D.  Alt + End 

ĐÁP ÁN ĐỀ KIỂM TRA 1 TIẾT TIN 12 – SỐ 1 

1A 2B 3A 4C 5C 6C 7D 8A 9C 10C 

11A 12A 13B 14B 15B 16A 17C 18C 19A 20A 

21A 22B 23B 24D 25D 26C 27C 28B 29A 30D 

31A 32C 33D 34C 35B 36D 37B 38A 39D 40V 

 

2. Đề kiểm tra 1 tiết HK1 môn Tin học 12 – Số 2 

TRƯỜNG THPT HÀ HUY TẬP ĐỀ KIỂM TRA 1 TIẾT HỌC KÌ 1 

MÔN TIN HỌC 12 

NĂM HỌC 2019-2020 

Thời gian làm bài: 45 phút 

I. PHẦN TRẮC NGHIỆM  
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Câu 1: Access là? 

A. Bộ phần mềm Microsoft Office.                        

B. Hệ quản tri cơ sở dữ liệu 

C. Ngôn ngữ lập trình.                                           

D. Cơ sở dữ liệu 

Câu 2: Các thao tác nào không phải các thao tác cơ bản trên bảng: 

A. Lọc                       

B. Cập nhật dữ liệu              

C. Sắp xếp                 

D. Xoá bảng và đổi tên bảng 

Câu 3: Chọn kiểu dữ liệu nào cho truờng điểm Toán, Lý....  

A. AutoNumber                  

B. Yes/No                    

C. Currency                             

D. Number             

Câu 4: Khi làm việc với đối tượng bảng, muốn sửa đổi thiết kế cấu trúc bảng, ta chọn nút 

lệnh: 

A. Open  

B. New                   

C. Preview              

D. Design 

Câu 5: Trong Access, dữ liệu kiểu ngày tháng được khai báo bằng từ? 

A. Day/Time     

B. Day/Type                    

C. Date/Type   

D. Date/Time 

Câu 6: Khi làm việc với Access xong, muốn thoát khỏi Access, ta thực hiện : 

A. View – Exit    

B. Tools – Exit                

C. File – Exit          

D. Windows – Exit 

II. PHẦN TỰ LUẬN  

Câu 1 (4đ). Giả sử CSDL Ql_thu_vien trong 1 trường THPT có các bảng và gồm các 

trường sau: 
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- NGUOI_MUON: (Ma_so_the, Ho_ten, Ngsinh, Lop) 

- PHIEU_MUON : (So_phieu, Ma_so_the, Ma_so_sach, Ngay_muon, Ngay_hen_tra) 

- SACH : (Ma_so_sach, Ten_sach, NXB, Tac_gia) 

Em hãy:  

a: Chọn kiểu dữ liệu hợp lý cho từng trường trong các bảng? Chọn khóa chính cho mỗi 

bảng. 

b: Trình bày các bước để tạo liên kết giữa bảng NGUOI_MUON và bảng PHIEU_MUON, 

bảng PHIEU_MUON và bảng SACH trong CSDL trên. 

c: Hãy tạo biểu mẫu để nhập DL cho bảng PHIEU_MUON. 

d:Tao báo cáo danh sách học sinh mượn theo tên sách gồm: Ho_ten, Ten_sach, 

Ngay_muon, Ngay_tra và nhóm theo tên sách. 

Câu 2:(2đ).  

Có bao nhiêu bước chính để tạo một mẫu hỏi?  

Câu 3:(1đ). 

Theo em nghành tin học đối với XH hiện nay có quan trọng hay không? Vì sao? Cho một 

vài VD? 

ĐÁP ÁN ĐỀ KIỂM TRA 1 TIẾT TIN 12 – SỐ 2 

I, Trắc nghiệm 

1.B               2.D              3.D               4.D             5.B               6.C 

II: Lý thuyết 

Câu 1:(4đ). 

A/ Chỉ định kiểu DL, Khóa chính.(1đ). 

NGUOI_MUON 

 

  

 

 

 

 

 

PHIEU_MUON  

Tên trường Kiểu DL Khóa chính 

So_phieu Text Khóa 

Ma_so_the Number  

Ma_so_sach Number  

Ngay_muon Date/Time  

Ngay_hen_tra Date/Time  
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SACH 

 

 

B. Tạo liên kết 

- NGUOI_MUON: Ma_so_the, Ho_ten, Ngsinh, Lop. 

- PHIEU_MUON : So_phieu, Ma_so_the, Ma_so_sach, Ngay_muon, Ngay_hen_tra. 

- SACH: Ma_so_sach, Ten_sach, NXB, Tac_gia. 

- Bảng NGUOI_MUON và bảng PHIEU_MUON đều có trường Ma_so_the ta dùng trường 

này để tạo liên kết. 

- Bảng SACH và bảng PHIEU_MUON đều có trường Ma_so_sach ta dùng trường này để 

tạo liên kết 

C. Tạo biểu mẫu  

B1: DL nguồn dùng cho biểu mẫu là: Bảng PHIEU_MUON. 

B2: Các trường đưa vào biểu mẫu: So_phieu, Ma_so_the, Ma_so_sach, Ngay_muon, 

Ngay_hen_tra. 

D. Tạo báo cáo:  

B1: Báo cáo kết xuất những thông tin: Ho_ten, Ten_sach, Ngay_muon, Ngay_tra. 

B2: DL nguồn đưa vào báo cáo: Bảng PHIEU_MUON, NGUOI_MUON, SACH. 

B3: DL được gộp nhóm theo tên sách 

Câu 2. Các bước chính để tạo một mẫu hỏi. 

- Chọn DL nguồn cho mẫu hỏi. 

- Chọn các trường từ DL nguồn để đưa vào mẫu hỏi. 

Tên 

trường 

Kiểu DL Khóa 

chính 

Ma_so_the Text   Khóa 

Ho_ten Text  

Ngay _sinh Date/Time  

Lop Text  

Tên trường Kiểu DL Khóa 

chính 

Ma_so_sach Text   Khóa 

Ten_sach Text  

NXB Text  

Tac_gia Text  
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- Khai báo các điều kiện cân đưa vào mẫu hỏi. 

- Chọn trường để sắp xếp các bản ghi trong mẫu hỏi. 

- Tạo các trường tính toán từ các trường đã có. 

- Đặt điều kiện gộp nhóm. 

Câu 3:  

- Hiện nay tin học rất quan trọng.  

- Vì mọi hoạt đông kinh tế XH đêu cần đến máy tính và sử dụng máy tính để quản lí. 

- VD: Nghành ngân hàng, Bưu điện, Cơ sở kinh doanh, Các công ty.... 

3. Đề kiểm tra 1 tiết HK1 môn Tin học 12 – Số 3 

TRƯỜNG THPT NGUYỄN TRÃI ĐỀ KIỂM TRA 1 TIẾT HỌC KÌ 1 

MÔN TIN HỌC 12 

NĂM HỌC 2019-2020 

Thời gian làm bài: 45 phút 

 

Phần lý thuyết trắc nghiệm:   

Câu 1: Thao tác đầu tiên để tạo liên kết cho các bảng: 

A. Tools Word Count       B.  Tools Language  

C. Tools Speech  D.  Tools Relationships  

Câu 2: Để xóa một trường ta chọn: 

A. Insert  Rows B. Edit  Primary Key 

C. Edit  Delete Rows D. File  new  Blank Database 

Câu 3: Cơ sở dữ liệu (CSDL) là   

A. Tập hợp dữ liệu chứa đựng các kiểu dữ liệu: ký tự, số, ngày/giờ, hình ảnh... của một chủ 

thể nào đó.   

B. Tập hợp dữ liệu có liên quan với nhau theo một chủ đề nào đó được lưu trên máy tính 

điện tử để đáp ứng nhu cầu khai thác thông tin của nhiều người.     

C. Tập hợp dữ liệu có liên quan với nhau theo một chủ đề nào đó được lưu trên máy tính 

điện tử. 

D.  Tập hợp dữ liệu có liên quan với nhau theo một chủ đề nào đó được ghi lên giấy. 

Câu 4: Chức năng “ sắp xếp, tìm kiếm và kết xuất dữ liệu xác định từ một hoặc nhiều bảng” 

là chức năng của đối tượng nào sau đây? 

A. Mẫu hỏi B. Biểu mẫu 

C. Báo cáo D. Bảng 
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Câu 5 Người có trách nhiệm quản lí các tài nguyên như CSDL, hệ QTCSDL, và các phần 

mêm liên quan, có vai trò cài đặt CSDL vật lí, cấp phát các quyền truy cập CSDL, cấp phần 

cứng và phần mềm theo yêu cầu của các các trình ứng dụng và người dùng. Gọi là gì trong 

những người sau đây ? 

A. Người lập trình ứng dụng B.  Người dùng 

C. Người quản trị CSDL D.  Đáp án khác 

Câu 6: Bảng DIEM gồm có các trường : SBD, HOTEN, TOAN, LI, HOA. Muốn tạo thêm một 

mẫu hỏi chứa các trường của bảng DIEM và có thêm trường TB, ta xây dựng biểu thức để 

tính điểm trung bình (TB) là : 

 A.  TB:(TOAN)+(LI)+(HOA)/3    B.  TB:([TOAN]+[LI]+[HOA])/3 

C.  TB= (TOAN+LI+HOA)/3   D.  TB= [TOAN]+[LI]+[HOA]/3 

Câu 7: Một hàng của bảng gồm dữ liệu về các thuộc tính của chủ thể được quản lí gọi là: 

A. Date/Time B.  Field 

C. Data Type D.  Record  

Câu 8: Chọn kiểu dữ liệu nào cho truờng điểm Toán, Lý, Tin,... 

A.   AutoNumber  B.  Number    

C.  Currency  D.  Yes/No 

Câu 9: Những công việc thường gặp khi xử lí thông tin của một tổ chức là:  

A. Tạo lập hồ sơ, cập nhật hồ sơ và khai thác hồ sơ. 

B. Tìm kiếm hồ sơ, thống kê hồ sơ 

C. Thêm, sửa, xóa hồ sơ 

D. Tìm kiếm, sắp xếp, thống kê, lập báo cáo hồ sơ 

Câu 10: Phát biểu: “Một hệ Quản trị CSDL cung cấp môi trường cho người dùng khai báo 

kiểu dữ liệu, các cấu trúc dữ liệu thể hiện thông tin và các ràng buộc dữ liệu  ” đó là phát 

biểu của chức năng nào sau đây?  

A. Cung cấp môi trường cập nhật và khai thác dữ liệu 

B. Cung cấp công cụ kiểm soát, điều khiển và truy cập vào CSDL 

C. Cung cấp môi trường tạo lập cơ sở dữ liệu  

D. Tất cả đều sai 

Câu 11: Cần tạo liên kết giữa các bảng vì :   

A. các bảng trong một CSDL thường có liên quan đến nhau  

B. có nhu cầu tổng hợp dữ liệu từ nhiều bảng 

C. cả A và B đều đúng. 

D. cả A và B đều sai. 
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Câu 12: Phần mềm Microsoft Access là ......... (A) ............. nằm trong bộ phần mềm Microsoft 

Office của hãng Microsoft dành cho máy tính cá nhân và máy tính chạy trong mạng cục bộ. 

Điền vào chỗ trống (A) từ ngữ thích hợp 

A. Dữ liệu 

B. Hệ quản trị Cơ sở dữ liệu  

C. Cơ sở dữ liệu 

D. Hệ Cơ sở dữ liệu 

Câu 13: Dữ liệu kiểu văn bản gồm các kí tự trong Access là: 

A. Yes/ No  B.  Date/ Time 

C. Currency  D.  Text  

Câu 14: Trong các hàm sau đây, hàm nào chỉ thực hiện trên các trường kiểu số 

A. SUM     B.  SUM, AVG, MIN, MAX  

C. SUM, AVG, MIN  D.  AVG, MIN, MAX, COUNT 

Câu 15: Khi chọn kiểu dữ liệu cho trường Địa chỉ  nên chọn loại nào ?   

A. Text    B. Autonumber   

C. Date/Time    D. Number 

Câu 16 : Để chỉ định khóa chính ta thực hiện : 

A. File  new  Blank Database B.  Vào File  New 

C. Edit Primary Key D.  File  Primary Key 

Câu 17: Tệp CSDL cuả Access có phần mở rộng là: 

A..mdb    B..doc  

C..mbd  D. .pas 

Câu 18: Khi xây dựng công thức trong loại đối tượng mẫu hỏi, hằng văn bản được viết 

trong 

A. Cặp dấu ngoặc nhọn B.  Cặp dấu ngoặc vuông 

C. Cặp dấu ngoặc kép D.  Đáp án khác. 

Câu 19: Để tạo mẫu hỏi, trong của sổ CSDL đang làm việc, nháy vào nhãn nào là đúng ?   

A.  Forms      B.  Queries  

C.  Reports           D.  Tables 

Câu 20: Trong các biểu thức sau biểu thức nào là biểu thức số học? 

A.  Thanh Tien: [SoLuong] * [DonGia]  B.  [GT] = “Nam” and [Tin] >= 8.5  

C.  [NoiSinh] = “Hà Nội” and [Diem TB] >= 7 D.  Cả A, B và C đều sai. 

Câu 21: Dùng chế độ nào dưới đây để thay đổi cấu trúc các bảng trong CSDL? 

A.  Chế độ thuật sĩ.     B.  Chế độ thiết kế. 
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C.  Chế độ biểu mẫu.                D.  Chế độ trang dữ liệu. 

Câu 22 : Chữ Tiếng Anh của thuật sĩ là gì ? 

A. View B.  Data   

C. Print      D.  Wizard  

Câu 23: Khi đang mở cửa sổ Relationship, để chỉnh sửa/xóa một liên kết giữa hai bảng, thực 

hiện: 

A. Nháy nút phải chuột lên liên kết để mở bảng chọn tắt, chọn Edit để sửa, chọn Delete để 

xóa.  

B. Nháy chọn liên kết rồi nhấn Delete để xóa; 

C. Nháy đúp lên liên kết để sửa ;  

D. Nháy chọn liên kết rồi nhấn Enter để sửa; 

Câu 24: Những người có nhiệm vụ xây dựng các chương trình ứng dụng là những người 

nào ? 

A. Người Quản trị CSDL    B.  Người dùng  

C. Người  lập trình ứng dụng   D. Cả A, B và C 

Câu 25: Thuật ngữ Data Type dùng để chỉ : 

A. Trường                 B. Kiểu dữ liệu  

C. Bản ghi                                     D. Tất cả đều sai.  

Câu 26: Biểu mẫu là một đối tượng trong Access dùng để thực hiện công việc chủ yếu nào   

A. Xem, nhập, sửa dữ liệu     

B.  Lập báo cáo  

C. Kết xuất thông tin  

D.  Tìm kiếm thông tin   

Câu 27: Hệ quản trị CSDL là   

A.  Phần mềm dùng tạo lập CSDL   

B.  Phần mềm dùng tạo lập, lưu trữ và khai thác thông tin của CSDL   

C.  Phần mềm để thao tác và xử lý các đối tượng trong CSDL 

D.  Phần mềm dùng tạo lập, lưu trữ một CSDL 

Câu 28: Bảng đã được hiển thị ở chế độ trang dữ liệu, muốn lọc những bản ghi theo ô dữ 

liệu đang chọn, thao tác thực hiện lệnh nào sau đây là đúng 

A.  Record/ Fillter/Fillter By Selection     

B.  Record/Sort/Sort Ascending   

C.  Record/Fillter/Fillter By Form   

D.  Insert/Colum 
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Câu 29: Nháy nút    để đóng cửa sổ Relationship. Nháy Yes để lưu lại liên kết, đúng 

hay sai ? 

A.  Đúng      B.  Sai 

Câu 30:  Điều kiện lọc nào dưới đây sử dụng lọc theo ô dữ liệu đang chọn ? 

A.  Những người là nam có lương lớn hơn 2.000.000   

B.  Những người sinh năm 1980 và có địa chỉ  ở Hà Nội. 

C.  Những người có mã số lớn hơn 100   

D.  Những người sinh năm 1980. 

Câu 31: Biểu thức logic được sử dụng trong các trường hợp nào ? 

A.  Thiết lập bộ lọc cho bảng.  B.  Thiết lập điều kiện lọc để tạo mẫu hỏi. 

C.  Cả A và B đều đúng.   D.  Cả A và B đều sai. 

Câu 32: Nếu thêm nhầm một bảng làm dữ liệu nguồn trong khi tạo mẫu hỏi, để bỏ bảng đó 

khỏi chế độ thiết kế, ta thực hiện : 

A.  Query → Remove Table  B.  Edit → Delete Table 

C.  Form → Remove Table        D.  Tất cả đều sai. 

Câu 33: Sau khi nhập dữ liệu vào bảng, phát hiện ra người nhập gõ nhầm chữ NG thành 

GN. Làm cách nào tốt nhất để có thể chỉnh sửa được lỗi này ? 

A. Lọc ra những bản ghi bị lỗi và sửa 

B. Thực hiện lệnh tìm kiếm và thay thế GN thành NG 

C. Tìm kiếm các bản ghi bị lỗi và sửa 

D. Tìm từ bản ghi đầu đến bản ghi cuối, gặp lỗi thì sửa. 

Câu 34: Phép toán số học trong mẫu hỏi là : 

A.  cộng (+), trừ (-), nhân (x), chia (:)  C.  cộng (+), trừ (-), nhân (*), chia (/) 

B.  cộng (+), trừ (-), nhân (*), chia ( :)        D.  Tất cả đều sai. 

Câu 35:  Phát biểu nào sai trong các phát biểu sau? 

A. Biểu mẫu được dùng để cập nhật dữ liệu 

B. Mẫu hỏi dùng để kết xuất dữ liệu từ nhiều bảng. 

C. Báo cáo dùng để tổng hợp và in dữ liệu theo khuôn dạng. 

D.  Bảng dùng để tổng hợp và in dữ liệu theo khuôn dạng. 

Câu 36: Đặc điểm nào sau đây không có ở biểu mẫu ? 

A.  Thực hiện thao tác thông qua nút lệnh. 

B.  Luôn hiển thị nhiều bản ghi cùng một lúc. 

C.   Hiển thị dữ liệu trong bảng dưới dạng thuận tiện để xem, nhập và sửa.  
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D.  Không có đặc điểm nào. 

Câu 37: Trong của sổ CSDL đang làm việc, để tạo mẫu hỏi bằng cách tự thiết kế, thao tác 

thực hiện lệnh nào sau đây là đúng ?    

A. Queries/ Create Queries by Using Wizard     B.Tables/Create Table in Design View   

C. Queries /Create Queries in Design View       D. Tables/Create Tables by Using Wizard 

Câu 38: Muốn xoá liên kết giữa hai bảng, trong cửa sổ Relationships ta thực hiện : 

A.  Chọn hai bảng và nhấn phím Delete. 

B.  Chọn đường liên kết giữa hai bảng đó và nhấn phím Delete. 

C.  Chọn tất cả các bảng và nhấn phím Delete.  

D.  Tất cả đều sai. 

Câu 39: Trong một công ty có hệ thống mạng nội bộ để sử dụng chung CSDL, nếu em được 

giao quyền tổ chức nhân sự, em có quyết định phân công một nhân viên đảm trách cả 03 vai 

trò: là người Quản trị CSDL, vừa là nguời lập trình ứng dụng, vừa là người dùng không? 

A. Không được     B. Không thể   

C. Được      D. Không nên  

Câu 40: Thao tác nào sau đây không là thao tác cập nhật dữ liệu ? 

A.  Xem dữ liệu  B.  Thêm bản ghi 

C.  Xoá bản ghi  D.  Nhập dữ liệu ban đầu 

ĐÁP ÁN ĐỀ KIỂM TRA 1 TIẾT TIN 12 – SỐ 3 

1D 2C 3C 4A 5C 6B 7D 8B 9A 10C 

11C 12B 13D 14B 15A 16C 17A 18C 19B 20A 

21B 22D 23A 24C 25B 26A 27B 28A 29A 30D 

31C 32A 33B 34C 35B 36B 37C 38B 39D 40A 

 

4. Đề kiểm tra 1 tiết HK1 môn Tin học 12 – Số 4 

TRƯỜNG THPT NHO QUAN 1 ĐỀ KIỂM TRA 1 TIẾT HỌC KÌ 1 

MÔN TIN HỌC 12 

NĂM HỌC 2019-2020 

Thời gian làm bài: 45 phút 

 

I.Phần Trắc nghiệm  

Câu 1: Trong Access có mấy đối tượng chính? 

A. 3 B. 4 C. 2 D. 1 
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Câu 2: Để tạo một tệp  cơ sở dữ liệu (CSDL)  mới & đặt tên tệp trong Access, ta phải; 

A. Vào File chọn New    

B. Khởi động Access, vào File chọn New hoặc nháy vào biểu tượng New 

C. Khởi động Access, vào File chọn New hoặc nháy vào biểu tượng New, nháy tiếp vào 

Blank DataBase đặt tên tệp và chọn Create.     

D. Kích vào biểu  tượng New 

Câu 3 Người có vai trò quan trọng nhất trong việc phân công quyền truy cập và sử dụng 

CSDL là ai? 

A. Người lập trình ứng dụng.  

B. Người quản trị CSDL và người lập trình ứng dụng. 

C. Người dùng.  

D. Người quản trị CSDL. 

Câu 4: Để sắp xếp dữ liệu trường nào đó tăng dần ta chọn biểu tượng nào sau đây? 

A. Biểu tượng ; B. Biểu tượng ;  

C. Biểu tượng . D. Biểu tượng ; 

Câu 5: Các yêu cầu cơ bản của hệ CSDL. 

A. Tính không dư thừa, tính nhất quán  

B. Tính cấu trúc, tính toàn vẹn 

C. Tính độc lập, tính chia sẻ dữ liệu, tính an toàn và bảo mật thông tin  

D. Các câu trên đều đúng 

Câu 6: Để thêm một bản ghi mới ta thực hiện thao tác nào sau đây? 

A. câu a và b đúng.    

D. Nháy vào biểu tượng   trên thanh công cụ rồi nhập dữ liệu     

C. Nháy biểu tượng  trên thanh công cụ rồi nhập dữ liệu;  

B. Chọn Insert → New Record rồi nhập dữ liệu; 

Câu 7: Chọn kiểu dữ liệu nào cho truờng điểm Toán, Văn,.... 

A. AutoNumber B. Yes/No C. Number  D. Currency 

Câu 8: Để lọc dữ liệu theo mẫu ta chọn biểu tượng nào sau đây? 

A. Biểu tượng ;  B. Biểu tượng ; 

C. Biểu tượng .  D. Biểu tượng ; 

Câu 9 : Trong báo cáo ta sử dụng hàm nào để tính tổng 

A. Sum  B. AVG  C. Min  D. Max 
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Câu 10: Để tính tổng các trường toan, van, su, NN ta sử dụng công thức nào sau đây 

A. =Sum     B. toan+van+su+NN  

C. =[toan]+[van]+[su]+[NN]   D.=Sum(toan+van+su+NN) 

II. Thực hành  

Câu 1: Khởi động Access, tạo CSDL với tên THITH. Trong CSDL này tạo bảng HOCSINH 

và hãy chọn kiểu dữ liệu thích hợp cho từng trường được mô tả bên dưới: (1đ) 

HOCSINH 

Tên trường Mô tả Khóa chính 

Maso Mã học sinh  

Hodem Họ và đệm  

Ten Tên  

GT Giới tính  

Ngsinh Ngày sinh  

Doanvien Là đoàn viên hay không  

Diachi Địa chỉ  

To Tổ  

Toan Điểm trung bình môn Toán  

Van Điểm trung bình môn Văn  

Tin Điểm trung bình môn Tin  

Câu 2: Nhập dữ liệu cho bảng HOCSINH theo mẫu  

Câu 3: Tạo mẫu hỏi theo bảng theo mẫu sau và tính tổng:  

 

Câu 4: Sắp xếp tên học sinh theo thứ tự tăng dần. 

ĐÁP ÁN ĐỀ KIỂM TRA 1 TIẾT TIN 12 – SỐ 4 
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I. Phần Trắc nghiệm  

Câu 1 2 3 4 5 6 7 8 9 10 

ĐA B C D B D A B C A C 

II. Phần thực hành  

Câu 1: (2đ) 

Khởi động Access, tạo CSDL với tên THITH  (1đ) 

Câu 2: Học sinh tạo nhập liệu theo yêu cầu (1đ); 

Câu 3: (2đ) 

- Tạo mẫu hỏi đúng (1đ) 

- Công thức tính tổng: =[Toan]+[Van]+[Tin] ( 1 đ) 

Câu 4: (1 đ) 

Bước 1: Chọn trường cần sắp xếp 

Bước 2: Nháy nút  trên thanh công cụ để sắp xếp 

5. Đề kiểm tra 1 tiết HK1 môn Tin học 12 – Số 5 

TRƯỜNG THPT NGHI LỘC 2 ĐỀ KIỂM TRA 1 TIẾT HỌC KÌ 1 

MÔN TIN HỌC 12 

NĂM HỌC 2019-2020 

Thời gian làm bài: 45 phút 

Câu 1: Những công việc thường gặp khi xử lí thông tin của một tổ chức là:  

A. Tìm kiếm hồ sơ, thống kê hồ sơ 

B. Tạo lập hồ sơ, cập nhật hồ sơ và khai thác hồ sơ. 

C. Thêm, sửa, xóa hồ sơ 

D. Tìm kiếm, sắp xếp, thống kê, lập báo cáo hồ sơ 

Câu 2: Để xóa một trường ta chọn: 

A. Edit  Delete Rows B. Edit  Primary Key 

C. Insert  Rows D. File  new  Blank Database 

Câu 3: Cần tạo liên kết giữa các bảng vì :   

A. các bảng trong một CSDL thường có liên quan đến nhau  

B. có nhu cầu tổng hợp dữ liệu từ nhiều bảng 

C. cả A và B đều đúng. 

D. cả A và B đều sai. 

Câu 4: Chức năng “ sắp xếp, tìm kiếm và kết xuất dữ liệu xác định từ một hoặc nhiều bảng” 

là chức năng của đối tượng nào sau đây? 
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A. Bảng B. Biểu mẫu 

C. Báo cáo D. Mẫu hỏi 

Câu 5: Phát biểu: “Một hệ Quản trị CSDL cung cấp môi trường cho người dùng khai báo kiểu 

dữ liệu, các cấu trúc dữ liệu thể hiện thông tin và các ràng buộc dữ liệu  ” đó là phát biểu của 

chức năng nào sau đây?  

A. Cung cấp môi trường cập nhật và khai thác dữ liệu 

B. Cung cấp môi trường tạo lập cơ sở dữ liệu 

C. Cung cấp công cụ kiểm soát , điều khiển và truy cập vào CSDL 

D. Tất cả đều sai 

Câu 6: Khi chọn kiểu dữ liệu cho trường Ngày sinh nên chọn loại nào ?   

A. Text    B. Autonumber  C. Date/Time   D. Number 

Câu 7: Người có trách nhiệm quản lí các tài nguyên như CSDL, hệ QTCSDL, và các phần 

mêm liên quan, có vai trò cài đặt CSDL vật lí, cấp phát các quyền truy cập CSDL, cấp phần 

cứng và phần mềm theo yêu cầu của các các trình ứng dụng và người dùng.      Gọi là gì 

trong những người sau đây ? 

A. Người lập trình ứng dụng B.  Người quản trị CSDL 

C. Người dùng D.  Đáp án khác 

Câu 8: Chọn kiểu dữ liệu nào cho truờng điểm Toán, Lý, Tin,... 

A.  Number    B.  AutoNumber    C.  Currency  D.  Yes/No 

Câu 9: Phần mềm Microsoft Access là ........... (A) ............. nằm trong bộ phần mềm Microsoft 

Office của hãng Microsoft dành cho máy tính cá nhân và máy tính chạy trong mạng cục bộ. 

Điền vào chỗ trống (A) từ ngữ thích hợp 

A. Dữ liệu 

B. Hệ Cơ sở dữ liệu 

C. Cơ sở dữ liệu 

D. Hệ quản trị Cơ sở dữ liệu 

Câu 10: Một hàng của bảng gồm dữ liệu về các thuộc tính của chủ thể được quản lí gọi là: 

A. Record B.  Field 

C. Data Type D.  Date/Time 

Câu 11: Dữ liệu kiểu văn bản gồm các kí tự trong Access là: 

A. Text B.  Date/ Time 

C. Currency D.  Yes/ No 

Câu 12: Dùng chế độ nào dưới đây để thay đổi cấu trúc các bảng trong CSDL? 

A.  Chế độ thuật sĩ.     B.  Chế độ trang dữ liệu. 
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C.  Chế độ biểu mẫu.    D.  Chế độ thiết kế. 

Câu 13 : Để chỉ định khóa chính ta thực hiện : 

A. File  new  Blank Database B.  Edit Primary Key  

C. Vào File  New D.  File  Primary Key 

Câu 14: Bảng DIEM gồm có các trường : SBD, HOTEN, TOAN, LI, HOA. Muốn tạo thêm một 

mẫu hỏi chứa các trường của bảng DIEM và có thêm trường TB, ta xây dựng biểu thức để 

tính điểm trung bình (TB) là : 

A.  TB:(TOAN)+(LI)+(HOA)/3    B.  TB= (TOAN+LI+HOA)/3 

C.  TB:([TOAN]+[LI]+[HOA])/3    D.  TB= [TOAN]+[LI]+[HOA]/3 

Câu 15: Tệp CSDL cuả Access có phần mở rộng là: 

A..pas  B.  .doc  

C.  .mbd  D.  .mdb  

Câu 16 : Chữ Tiếng Anh của thuật sĩ là gì ? 

A. View B.  Wizard  

C. Print D.  Data 

Câu 17: Thao tác đầu tiên để tạo liên kết cho các bảng: 

A. Tools Relationships B.  Tools Language  

C. Tools Speech  D.  Tools Word Count 

Câu 18: Khi xây dựng công thức trong loại đối tượng mẫu hỏi, hằng văn bản được viết 

trong 

A. Cặp dấu ngoặc nhọn B.  Cặp dấu ngoặc kép  

C. Cặp dấu ngoặc vuông D.  Đáp án khác. 

Câu 19: Trong các hàm sau đây, hàm nào chỉ thực hiện trên các trường kiểu số 

A. SUM B.  SUM, AVG, MIN 

C. SUM, AVG, MIN, MAX D.  AVG, MIN, MAX, COUNT 

Câu 20: Trong các biểu thức sau biểu thức nào là biểu thức số học? 

A.  Thanh Tien: [SoLuong] * [DonGia]  B.  [GT] = “Nam” and [Tin] >= 8.5  

C.  [NoiSinh] = “Hà Nội” and [Diem TB] >= 7 D.  Cả A, B và C đều sai. 

Câu 21: Khi đang mở cửa sổ Relationship, để chỉnh sửa/xóa một liên kết giữa hai bảng, thực 

hiện: 

A. Nháy chọn liên kết rồi nhấn Enter để sửa;  

B. Nháy chọn liên kết rồi nhấn Delete để xóa; 

C. Nháy đúp lên liên kết để sửa ;  
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D. Nháy nút phải chuột lên liên kết để mở bảng chọn tắt, chọn Edit để sửa, chọn Delete để 

xóa. 

Câu 22: Cơ sở dữ liệu (CSDL) là   

A.  Tập hợp dữ liệu chứa đựng các kiểu dữ liệu: ký tự, số, ngày/giờ, hình ảnh... của một chủ 

thể nào đó.   

B.  Tập hợp dữ liệu có liên quan với nhau theo một chủ đề nào đó được lưu trên máy tính 

điện tử.   

C.  Tập hợp dữ liệu có liên quan với nhau theo một chủ đề nào đó được lưu trên máy tính 

điện tử để đáp ứng nhu cầu khai thác thông tin của nhiều người.   

D.  Tập hợp dữ liệu có liên quan với nhau theo một chủ đề nào đó được ghi lên giấy. 

Câu 23: Trong của sổ CSDL đang làm việc, để tạo mẫu hỏi bằng cách tự thiết kế, thao tác 

thực hiện lệnh nào sau đây là đúng ?    

A. Queries /Create Queries in Design View       

B.Tables/Create Table in Design View   

C. Queries/ Create Queries by Using Wizard      

D. Tables/Create Tables by Using Wizard 

Câu 24: Những người có nhiệm vụ xây dựng các chương trình ứng dụng là những người 

nào ? 

A. Người Quản trị CSDL    B.  Người  lập trình ứng dụng  

C. Người dùng     D. Cả A, B và C 

Câu 25: Hệ quản trị CSDL là   

A.  Phần mềm dùng tạo lập CSDL   

B.  Phần mềm để thao tác và xử lý các đối tượng trong CSDL   

C.  Phần mềm dùng tạo lập, lưu trữ và khai thác thông tin của CSDL   

D.  Phần mềm dùng tạo lập, lưu trữ một CSDL 

Câu 26: Để tạo mẫu hỏi, trong của sổ CSDL đang làm việc, nháy vào nhãn nào là đúng ?   

A.  Queries     B.  Forms  

C.  Reports       D.  Tables 

Câu 27: Biểu mẫu là một đối tượng trong Access dùng để thực hiện công việc chủ yếu nào   

A. Tìm kiếm thông tin      B.  Lập báo cáo  

C. Kết xuất thông tin    D.  Xem, nhập, sửa dữ liệu 

Câu 28: Bảng đã được hiển thị ở chế độ trang dữ liệu, muốn lọc những bản ghi theo ô dữ 

liệu đang chọn, thao tác thực hiện lệnh nào sau đây là đúng 

A.  Record/Fillter/Fillter By Form    
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B.  Record/Sort/Sort Ascending   

C.  Record/ Fillter/Fillter By Selection  

D.  Insert/Colum 

Câu 29:  Phát biểu nào sai trong các phát biểu sau? 

D. Biểu mẫu được dùng để cập nhật dữ liệu 

E. Bảng dùng để tổng hợp và in dữ liệu theo khuôn dạng. 

F. Báo cáo dùng để tổng hợp và in dữ liệu theo khuôn dạng. 

G. Mẫu hỏi dùng để kết xuất dữ liệu từ nhiều bảng. 

Câu 30:  Điều kiện lọc nào dưới đây sử dụng lọc theo ô dữ liệu đang chọn ? 

A.  Những người là nam có lương lớn hơn 2.000.000   

B.  Những người sinh năm 1980. 

C.  Những người có mã số lớn hơn 100   

D.  Những người sinh năm 1980 và có địa chỉ  ở Hà Nội. 

Câu 31: Sau khi nhập dữ liệu vào bảng, phát hiện ra người nhập gõ nhầm chữ NG thành 

GN. Làm cách nào tốt nhất để có thể chỉnh sửa được lỗi này ? 

E. Lọc ra những bản ghi bị lỗi và sửa 

F. Tìm kiếm các bản ghi bị lỗi và sửa 

G. Thực hiện lệnh tìm kiếm và thay thế GN thành NG 

H. Tìm từ bản ghi đầu đến bản ghi cuối, gặp lỗi thì sửa. 

Câu 32: Thuật ngữ Data Type dùng để chỉ : 

A. Trường                B. Kiểu dữ liệu  

C. Bản ghi       D. Tất cả đều sai. 

Câu 33: Đặc điểm nào sau đây không có ở biểu mẫu ? 

A.  Luôn hiển thị nhiều bản ghi cùng một lúc. 

B.  Thực hiện thao tác thông qua nút lệnh. 

C.   Hiển thị dữ liệu trong bảng dưới dạng thuận tiện để xem, nhập và sửa.  

D.  Không có đặc điểm nào. 

Câu 34: Thao tác nào sau đây không là thao tác cập nhật dữ liệu ? 

A.  Nhập dữ liệu ban đầu  B.  Thêm bản ghi 

C.  Xoá bản ghi     D.  Xem dữ liệu  

Câu 35: Muốn xoá liên kết giữa hai bảng, trong cửa sổ Relationships ta thực hiện : 

A.  Chọn đường liên kết giữa hai bảng đó và nhấn phím Delete. 

B.  Chọn hai bảng và nhấn phím Delete. 

C.  Chọn tất cả các bảng và nhấn phím Delete.  
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D.  Tất cả đều sai. 

Câu 36: Biểu thức logic được sử dụng trong các trường hợp nào ? 

A.  Thiết lập bộ lọc cho bảng.   

B.  Thiết lập điều kiện lọc để tạo mẫu hỏi. 

C.  Cả A và B đều sai.    

D.  Cả A và B đều đúng. 

Câu 37: Phép toán số học trong mẫu hỏi là : 

A.  cộng (+), trừ (-), nhân (x), chia (:)  C.  cộng (+), trừ (-), nhân (*), chia (/) 

B.  cộng (+), trừ (-), nhân (*), chia ( :)       D.  Tất cả đều sai. 

Câu 38: Nháy nút    để đóng cửa sổ Relationship. Nháy Yes để lưu lại liên kết, đúng 

hay sai ? 

A.  Đúng       

B.  Sai 

Câu 39: Trong một công ty có hệ thống mạng nội bộ để sử dụng chung CSDL, nếu em được 

giao quyền tổ chức nhân sự, em có quyết định phân công một nhân viên đảm trách cả 03 vai 

trò: là người Quản trị CSDL, vừa là nguời lập trình ứng dụng, vừa là người dùng không? 

A. Không nên     B. Không thể   

C. Được      D. Không được 

Câu 40: Nếu thêm nhầm một bảng làm dữ liệu nguồn trong khi tạo mẫu hỏi, để bỏ bảng đó 

khỏi chế độ thiết kế, ta thực hiện : 

A.  Edit → Delete Table     

B.  Query → Remove Table 

C.  Form → Remove Table         

D.  Tất cả đều sai. 

ĐÁP ÁN ĐỀ KIỂM TRA 1 TIẾT TIN 12 – SỐ 5 

1B 2A 3C 4D 5B 6C 7B 8A 9D 10A 

11A 12D 13B 14C 15D 16B 17A 18B 19C 20A 

21D 22C 23A 24B 25C 26A 27D 28C 29B 30B 

31C 32B 33A 34D 35A 36D 37C 38A 39A 40B 

 

6. Đề kiểm tra 1 tiết HK1 môn Tin học 12 – Số 6 

TRƯỜNG THPT LƯƠNG ĐỊNH CỦA ĐỀ KIỂM TRA 1 TIẾT HỌC KÌ 1 

MÔN TIN HỌC 12 
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NĂM HỌC 2019-2020 

Thời gian làm bài: 45 phút 

Câu 1: Công việc thường gặp khi xử lí thông tin của một tổ chức? 

A. Tạo lập hồ sơ  B. Cập nhật hồ sơ 

C. Khai thác hồ sơ  D. Tất cả công việc trên 

Câu 2: Chọn câu đúng trong các câu sau: 

A. Máy tính điện tử ra đời trước CSDL và Hệ quản trị CSDL 

B. Máy tính điện tử ra đời sau CSDL và Hệ quản trị CSDL 

C. Hệ quản trị CSDL ra đời trước máy tính điện tử và CSDL 

D. Hệ quản trị CSDL , máy tính điện tử và CSDL cùng ra đời cùng một thời điểm 

Câu 3: Để lưu trữ và khai thác thông tin bằng máy tính cần phải có: 

A.CSDL, Hệ QTCSDL, các thiết bị vật lí B. Hệ CSDL, các thiết bị vật lí 

C.Các thiết bị vật lí    D.Hệ QTCSDL 

Câu 4: Công việc thường gặp khi xử lý thông tin của một tổ chức là: 

A.Tạo lập hồ sơ, cập nhật hồ sơ, khai thác hồ sơ B. Tạo lập hồ sơ, khai thác hồ sơ  

C.Sửa chữa hồ sơ, bổ sung hồ sơ, xoá hồ sơ  D.Tìm kiếm, thống kê, sắp xếp, lập 

báo cáo 

Câu 5: Cơ sở dữ liệu (CSDL) là: 

A. Tập hợp các dữ liệu có liên quan với nhau theo một chủ đề nào đó được lưu trên các 

thiết bị nhớ để đáp ứng nhu cầu khai thác thông tin của nhiều người. 

B. Tập hợp dữ liệu có liên quan với nhau theo một chủ đề nào đó được lưu trên máy tính 

điện tử. 

C. Tập hợp dữ liệu có liên quan với nhau theo một chủ đề nào đó được ghi lên giấy. 

D. Tập hợp dữ liệu chứa đựng các kiểu dữ liệu: ký tự, số, ngày/giờ, hình ảnh... của một 

chủ thể nào đó. 

Câu 6: Để tạo lập hồ sơ cần thực hiện công việc nào trong những công việc sau: 

A. Xác định cấu trúc hồ sơ     

B. Bổ sung hồ sơ 

C.Sắp xếp hồ sơ theo một tiêu chí nào đó   

D.Sửa hồ sơ 

Câu 7: Chọn phát biểu sai: 

A.CSDL bao gồm hệ CSDL và hệ quản trị CSDL để khai thác CSDL đó. 

B. Hệ CSDL bao gồm một CSDL và hệ quản trị CSDL để khai thác CSDL đó. 

C.Hệ quản trị CSDL là phần mềm phục vụ tạo lập CSDL và khai thác thông tin từ CSDL. 
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D.Yêu cầu của CSDL về tính toàn vẹn là: Dữ liệu phải thoả mãn một số ràng buộc của thực 

tiễn. 

Câu 8: Tìm kiếm là việc: 

A.tra cứu các thông tin có sẵn trong hồ sơ   

B. sắp xếp hồ sơ theo một tiêu chí nào đó 

C.khai thác hồ sơ dựa trên tình toán    

D.sử dụng các kết quả tìm kiếm, thống kê 

Câu 9: Lập báo cáo là việc: 

A.sử dụng các kết quả tìm kiếm, thống kê   

B. sắp xếp hồ sơ theo một tiêu chí nào đó 

C.khai thác hồ sơ dựa trên tình toán    

D.tra cứu các thông tin có sẵn trong hồ sơ 

Câu 10: Thống kê là việc: 

A.khai thác hồ sơ dựa trên tình toán    

B. sắp xếp hồ sơ theo một tiêu chí nào đó 

C.tra cứu các thông tin có sẵn trong hồ sơ     

D.sử dụng các kết quả tìm kiếm, thống kê 

Câu 11: Hệ quản trị CSDL là: 

A.Phần mềm dùng tạo lập, lưu trữ và khai thác một CSDL 

B. Phần mềm dùng tạo lập, lưu trữ một CSDL 

C.Phần mềm để thao tác và xử lý các đối tượng trong CSDL 

D.Tập hợp các dữ liệu có liên quan 

Câu 12: Việc xác định cấu trúc của hồ sơ được tiến hành vào thời điểm nào? 

A.Trước khi nhập hồ sơ vào trong máy tính. 

B. Trước khi thực hiện các phép tìm kiếm và tra cứu thông tin 

C.Sau khi đã nhập hồ sơ vào trong máy tính. 

D.Cùng lúc với việc nhập và cập nhật hồ sơ 

Câu 13: Người nào có vai trò chịu trách nhiệm quản lý các tài nguyên. 

A.Nguời quản trị CSDL    B. Người dùng 

C.Người lập trình ứng dụng   D.Cả ba người 

Câu 14: Ngôn ngữ định nghĩa dữ liệu bao gồm các lệnh cho phép 

A.Khai báo kiểu dữ liệu, cấu trúc dữ liệu, các ràng buộc trên dữ liệu của CSDL. 

B. Mô tả các đối tượng được lưu trữ trong CSDL. 

C.Ngăn chặn sự truy cập bất hợp pháp. 

http://www.elib.vn/


    Website: www.eLib.vn  | Facebook: eLib.vn 
 

eLib.vn: Thư viện trực tuyến miễn phí 25 

 

D.Đảm bảo tính độc lập dữ liệu. 

Câu 15: Người nào đã tạo ra các phần mềm ứng dụng đáp ứng nhu cầu khai thác thông tin 

từ CSDL 

A.Người  lập trình ứng dụng   B. Người QTCSDL  

C.Người dùng     D.Cả ba người 

Câu 16: Ngôn ngữ thao tác dữ liệu bao gồm các lệnh cho phép 

A.Nhập, sửa, xóa dữ liệu, cập nhật dữ liệu 

B. Khai báo kiểu, cấu trúc, các ràng buộc trên dữ liệu của CSDL 

C.Truy vấn CSDL 

D.Phục hồi các lỗi dữ liệu từ các lỗi hệ thống 

Câu 17: Trong một công ty có hệ thống mạng nội bộ để sử dụng chung CSDL, nếu em được 

giao quyền tổ chức nhân sự, em có quyết định phân công một nhân viên đảm trách cả 03 vai 

trò: vừa là người QTCSDL, vừa là nguời lập trình ứng dụng, vừa là người dùng không? 

A.Không nên  B. Không được C.Được D.Không thể 

Câu 18: Người nào có vai trò quan trọng trong vấn đề sử dụng phần mềm ứng dụng phục 

vụ nhu cầu khai thác thông tin 

A.Người dùng    B. Người  lập trình 

C.Người QTCSDL    D.Cả ba người  

Câu 19: Câu nào trong các câu dưới đây không thuộc công cụ kiểm soát, điều khiển truy 

cập vào CSDL? 

A.Cập nhật (thêm, sửa, xóa dữ liệu)     

B. Khôi phục CSDL khi có sự cố 

C.Phát hiện và ngăn chặn sự truy cập không được phép  

D.Duy trì tính nhất quán của CSDL 

Câu 20: Một trong những vai trò của người quản trị cơ sở dữ liệu (CSDL) là: 

A.Người chịu trách nhiệm quản lí các tài nguyên 

B. Người có nhu cầu khai thác thông tin từ CSDL 

C.Người có nhiệm vụ xây dựng các chương trình ứng dụng 

D.Người có quyền truy cập và khai thác CSDL 

Câu 21: Các bước để xây dựng CSDL: 

A.Khảo sát, thiết kế, kiểm thử   B. Khảo sát, cập nhật, khai thác 

C.Tạo lập, cập nhật, khai thác   D.Tạo lập, lưu trữ, khai thác 

Câu 22: Hệ quản trị CSDL gồm: 

A.Oracle, Access, MySQL    B. Access, Word, Excel 
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C.MySQL, Access, Excel    D.Access, Excel, Oracle 

Câu 23: Câu nào trong các câu dưới đây không thuộc bước Khảo sát: 

A. Lựa chọn hệ QTCSDL 

B. Tìm hiểu các yêu cầu của công tác quản lí 

C.Xác định khả năng phần mềm, phần cứng có thể khai thác, sử dụng 

D.Phân tích các chức năng cần có của hệ thống khai thác thông tin 

Câu 24: Câu nào trong các câu dưới đây không thuộc bước Thiết kế: 

A.Xác định dữ liệu cần lưu trữ, phân tích mối liên hệ giữa chúng 

B. Thiết kế CSDL 

C.Xây dựng hệ thống chương trình ứng dụng 

D.Lựa chọn hệ QTCSDL để khai thác 

Câu 25: Chọn câu sai nói về chức năng của hệ QTCSDL: 

A.Cung cấp công cụ quản lý bộ nhớ 

B. Cung cấp môi trường tạo lập CSDL 

C.Cung cấp môi trường cập nhật và khai thác dữ liệu 

D.Cung cấp công cụ kiểm soát, điều khiển việc truy cập vào CSDL 

ĐÁP ÁN ĐỀ KIỂM TRA 1 TIẾT TIN 12 – SỐ 6 

1D 2A 3A 4A 5A 

6A 7A 8A 9A 10A 

11A 12A 13A 14A 15A 

16A 17A 18A 19A 20A 

21A 22A 23A 24A 25A 

 

7. Đề kiểm tra 1 tiết HK1 môn Tin học 12 – Số 7 

TRƯỜNG THPT CHUYÊN LAM SƠN ĐỀ KIỂM TRA 1 TIẾT HỌC KÌ 1 

MÔN TIN HỌC 12 

NĂM HỌC 2019-2020 

Thời gian làm bài: 45 phút 

 

Câu 1: Access là phần mềm chuyên dùng để: 

A.Xử lí văn bản   B. Xử lí bảng tính điện tử 

C.Quản trị cơ sở dữ liệu  D.Quản lí hệ thống 

Câu 2: Thứ tự các việc khi làm việc với CSDL: 
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A.Nhập dữ liệu  Tạo lập CSDL  Chỉnh sửa dữ liệu  Khai thác và tìm kiếm dữ liệu 

B. Tạo lập CSDL  Nhập dữ liệu  Chỉnh sửa dữ liệu  Khai thác và tìm kiếm dữ liệu 

C.Chỉnh sửa dữ liệu  Nhập dữ liệu  Tạo lập CSDL  Khai thác và tìm kiếm dữ liệu 

D.Khai thác và tìm kiếm dữ liệuNhập dữ liệu  Tạo lập CSDL  Chỉnh sửa dữ liệu   

Câu 3: Tệp CSDL của Access có phần mở rộng là: 

A. *.BDF  B. *.MDB  C. *.ASC  D. *.XLS 

Câu 4: Trong CSDL Access đối tượng Bảng (Table) dùng để: 

A.Sắp xếp, tìm kiếm và kết xuất dữ liệu từ một hoặc nhiều bảng 

B. Nhập hoặc hiển thị thông tin một cách thuận lợi 

C.Lưu dữ liệu 

D.Định dạng, tính toán, tổng hợp các dữ liệu 

Câu 5: Trong CSDL Access đối tượng Mẫu hỏi (Query) dùng để: 

A.Sắp xếp, tìm kiếm và kết xuất dữ liệu từ một hoặc nhiều bảng 

B. Nhập hoặc hiển thị thông tin một cách thuận lợi 

C.Lưu dữ liệu 

D.Định dạng, tính toán, tổng hợp các dữ liệu 

Câu 6: Trong CSDL Access đối tượng Biểu mẫu (Form) dùng để: 

A.Sắp xếp, tìm kiếm và kết xuất dữ liệu từ một hoặc nhiều bảng 

B. Nhập hoặc hiển thị thông tin một cách thuận lợi 

C.Lưu dữ liệu 

D.Định dạng, tính toán, tổng hợp các dữ liệu 

Câu 7: Trong CSDL Access đối tượng Báo cáo (Report) dùng để: 

A.Sắp xếp, tìm kiếm và kết xuất dữ liệu từ một hoặc nhiều bảng 

B. Nhập hoặc hiển thị thông tin một cách thuận lợi 

C.Lưu dữ liệu 

D.Định dạng, tính toán, tổng hợp các dữ liệu 

Câu 8: Để thoát khỏi MS Access ta thực hiện 

A.Chọn File, chọn Close   B. Chọn File, chọn Exit 

C.Tổ hợp phím Alt + F4   D.Chọn File, chọn Quit 

Câu 9: Sau khi khởi động MS Access thành phần Blank Database dùng để: 

A.Tạo mới tệp CSDL rỗng   B. Sửa đổi tệp CSDL đã có 

C.Tạo một Bảng mới   D.Mở tệp CSDL đã có 

Câu 10: Để mở một CSDL đã có ta thực hiện: 

A.Chọn File, chọn Open    

http://www.elib.vn/


    Website: www.eLib.vn  | Facebook: eLib.vn 
 

eLib.vn: Thư viện trực tuyến miễn phí 28 

 

B. Chọn File, chọn Open, chọn tên tệp, chọn OK 

C.Chọn File, chọn Open, chọn Database, chọn Open 

D.Chọn Database, chọn Open, chọn tên tệp, chọn OK 

Câu 11: Chọn phát biểu sai. Để tạo đối tượng mới 

A.Người dùng tự thiết kế 

B. Dùng các mẫu dựng sẵn 

C.Người dùng tự thiết kế sau đó dùng các mẫu dựng sẵn để chỉnh sửa 

D.Dùng các mẫu dựng sẵn sau đó người dùng tự thiết kế để chỉnh sửa 

Câu 12: Ở chế độ thiết kế (Design View) không cho phép 

A.Tạo đối tượng mới       

B. Thay đổi cấu trúc bảng, biểu mẫu 

C.Thay đổi cách trình bày và định dạng biểu mẫu, báo cáo  

D.Thay đổi dữ liệu đã có 

Câu 13: Ở chế độ trang dữ liệu (Datasheet View) không cho phép 

A.Hiển thị dữ liệu dạng bảng   B. Xem ,xoá các dữ liệu đã có 

C.Thay đổi cấu trúc bảng, biểu mẫu  D.Thay đổi dữ liệu đã có 

Câu 14: Thành phần cơ sở tạo nên CSDL là: 

A. Table B. Field  C. Datatype  D. Record 

Câu 15: Chọn phát biểu sai 

A.Mỗi trường là một cột của bảng 

B. Mỗi bản ghi là một hàng của bảng 

C.Kiểu dữ liệu là kiểu của dữ liệu lưu trong một bản ghi 

D.Bảng là thành phần cơ sở tạo nên CSDL 

Câu 16: Khi tạo cấu trúc bảng, cần thực hiện: 

1-Tạo các trường 

2-Lưu bảng 

3-Chọn kiểu dữ liệu 

4-Nháy đúp lệnh Create table in Design view 

Thứ tự thực hiện nào sau đây là thích hợp nhất 

A.1, 2, 3, 4  B. 4, 3, 2, 1  C. 4, 1, 3, 2  D.1, 4, 3, 2 

Câu 17: Khi tạo một trường mới, cần thực hiện 

1-Chọn kiểu dữ liệu 

2-Đặt tên trường 

3-Xác định các tính chất của trường 
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4-Mô tả các tính chất của trường 

Thứ tự thực hiện nào sau đây là thích hợp nhất 

A.1, 2, 3, 4  B. 2, 1, 4, 3  C. 2, 3, 4, 1  D.1, 2, 4, 3 

Câu 18: Phát biểu nào sau đây là đúng 

A.Kiểu dữ liệu Text có độ dài tối đa là 255 kí tự   

B. Kiểu dữ liệu Text có độ dài tối đa là 65536 kí tự 

C.Kiểu dữ liệu Text có độ dài không giới hạn        

D.Kiểu dữ liệu Text có độ dài tối đa là 65535 kí tự 

Câu 19: Chỉnh sửa cấu trúc bảng là 

A.Thêm trường, thêm bản ghi    

B. Thêm hoặc xoá trường, thêm hoặc xoá bản ghi 

C.Thêm hoặc xoá trường    

D.Thêm hoặc xoá bản ghi 

Câu 20: Tính chất nào cho phép đặt kích thước tối đa của trường 

A.Field size  B. Format  C.Caption  D.Default Value 

Câu 21: Tính chất nào quy định cách hiển thị dữ liệu 

A.Field size  B. Format  C.Caption  D.Default Value 

Câu 22: Tính chất nào cho phép thay tên trường bằng các phụ đề 

A.Field size  B. Format  C.Caption  D.Default Value 

Câu 23: Tính chất nào xác định giá trị tự động đưa vào trường khi tạo bản ghi mới 

A.Field size  B. Format  C.Caption  D.Default Value 

Câu 24: Để thay đổi cấu trúc bảng 

A.Ta hiển thị bảng ở chế độ thiết kế    

B. Ta hiển thị bảng ở chế độ trang dữ liệu 

C.Ta hiển thị bảng ở chế độ biểu mẫu   

D.Ta hiển thị bảng ở chế độ mẫu hỏi 

Câu 25: Để thêm trường 

A.Chọn Insert, chọn Rows    B. Chọn Insert, chọn Field 

C.Chọn Insert, chọn Field Name   D.Chọn Insert, chọn Record 

Câu 26: Để xoá trường, ta chọn trường rồi thực hiện 

A.Chọn Edit, chọn Delete    B. Chọn Edit, chọn Delete Rows 

C.Chọn Edit, chọn Delete Field   D.Chọn Edit, chọn Delete Record 

Câu 27: Để xoá bảng, ta chọn bảng rồi thực hiện 

A.Chọn Edit, chọn Delete    B. Chọn Edit, chọn Delete Table 
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C.Chọn File, chọn Delete    D.Chọn File, chọn Delete Table 

Câu 28: Trường GIOI_TINH, DOAN_VIEN ta chọn kiểu dữ liệu nào là tốt nhất 

A.Text  B. Yes/No  C.Number  D.Memo 

Câu 29: Sau khi thực hiện việc tìm kiếm thông tin trong 1 tệp hồ sơ học sinh, khẳng định 

nào sau đây là đúng? 

A.Trình tự các hồ sơ trong tệp không thay đổi. 

B. Trình tự các hồ sơ trong tệp không thay đổi, nhưng những thông tin tìm thấy đã được 

lấy ra nên không còn trong những hồ sơ tương ứng. 

C.Tệp hồ sơ có thể xuất hiện những hồ sơ mới. 

D. Những hồ sơ tìm được sẽ không còn tệp vì người ta đã lấy thông tin ra. 

Câu 30: Xét tệp lưu trữ hồ sơ học bạ của học sinh, trong đó lưu trữ điểm tổng kết của các 

môn Văn, Toán, Sinh, Sử, Địa. Việc nào sau đây không tìm kiếm được. 

A.Tìm học sinh có điểm trung bình các môn vừa cao nhất và thấp nhất 

B. Tìm học sinh có điểm tổng kết môn Toán thấp nhất. 

C.Tìm học sinh nữ có điểm môn Toán cao nhất và học sinh nam có điểm môn Văn thấp 

nhất. 

D.Tìm học sinh có điểm tổng kết môn Văn cao nhất 

ĐÁP ÁN ĐỀ KIỂM TRA 1 TIẾT TIN 12 – SỐ 7 

1C 2B 3B 4C 5A 6B 7D 8B 9A 10B 

11C 12D 13C 14A 15C 16C 17B 18A 19C 20A 

21B 22C 23D 24A 25A 26B 27A 28B 29A 30A 

 

8. Đề kiểm tra 1 tiết HK1 môn Tin học 12 – Số 8 

TRƯỜNG THPT MAI THÚC LOAN ĐỀ KIỂM TRA 1 TIẾT HỌC KÌ 1 

MÔN TIN HỌC 12 

NĂM HỌC 2019-2020 

Thời gian làm bài: 45 phút 

Câu 1: Hai bản thiết kế CSDL quản lí đoàn viên khác nhau duy nhất ở một trường: bản thiết 

kế thứ nhất lưu tuổi Đoàn, bản thiết kế thứ hai lưu ngày vào Đoàn. Hãy cho biết ý kiến nào 

đúng và lí do: 

a)   Thiết kế thứ nhất tốt hơn vì xác định được tuổi Đoàn mà không cần tính toán. 

b)   Thiết kế thứ hai tốt hơn vì không phải cập nhật thông tin hằng năm về tuổi Đoàn. 

c)   Cả hai bản thiết kế tốt như nhau vì không vi phạm các yêu cầu cơ bản của hệ CSDL. 
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d)   Các ý kiến trên đều không đúng. 

Câu 2: Access là gì ? 

a)  Phần mềm b)  Phần cứng 

c)  Hệ quản trị cơ sở dữ liệu              d)  Cả A, B, C đều sai. 

Câu 3: Nhập dữ liệu cho bảng nhờ biểu mẫu có gì hơn so với nhập trực tiếp vào bảng ? 

a)   Nhanh hơn nếu biểu mẫu được tổ chức giao diện thuận tiện. 

b)   Thuận tiện hơn cho người nhập dữ liệu vì thao tác đơn giản hơn. 

c)   Hạn chế khả năng nhầm lẫn.  

d)   Các ưu việt trên. 

Câu 4:  Độ rộng của trường có thể được thay đổi ở đâu ? 

a)   Trong chế độ thiết kế  b)   Trong chế độ trang dữ liệu 

c)   Cả a) và b) đều đúng          d)   Không thể thay đổi được. 

Câu 5:  Để chỉ định khoá chính cho một bảng, sau khi chọn trường ta thực hiện : 

a)   Chọn Edit → Primary key  b)   Chọn Table → Edit key 

c)   Chọn View → Primary key  d)   Tất cả đều sai. 

Câu 6: Thay đổi cấu trúc bảng là : 

a)   Thêm trường mới                              b)   Thay đổi trường (tên, kiểu dữ liệu,…) 

c)   Xoá trường                                         d)   Tất cả các thao tác trên 

Câu 7: Thao tác nào sau đây không là thao tác cập nhật dữ liệu ? 

a)   Nhập dữ liệu ban đầu  b)   Xem dữ liệu 

c)   Xoá bản ghi  d)   Thêm bản ghi 

Câu 8: Để xoá một trường, chọn trường đó rồi nhấn : 

a)   Phím Delete b)   Tổ hợp phím Ctrl + D 

c)   Tổ hợp phím Ctrl + Y d)   Tổ hợp phím Ctrl + Delete 

Câu 9: Khi nào có thể nhập dữ liệu vào bảng ? 

a)   Ngay sau khi CSDL được tạo ra  b)   Bất cứ khi nào có dữ liệu 

c)   Bất cứ lúc nào cần nhập dữ liệu       d)   Sau khi bảng đã được tạo trong CSDL. 

Câu 10: Chế độ trang dữ liệu của bảng không cho phép thực hiện thao tác nào trong các 

thao tác dưới đây ? 

a) Thêm bản ghi mới    b) Chỉnh sửa nội dung các bản ghi 

c) Thêm/ bớt trường của bảng   d) Xoá bản ghi. 

Câu 11: Đặc điểm nào sau đây không có ở biểu mẫu ? 

a)   Luôn hiển thị nhiều bản ghi cùng một lúc. 

b)   Thực hiện thao tác thông qua nút lệnh. 
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c)   Hiển thị dữ liệu trong bảng dưới dạng thuận tiện để xem, nhập và sửa.  

d)   Không có đặc điểm nào.  

Câu 12: Biểu mẫu trong chế độ thiết kế không cho phép : 

a)   Thay đổi nội dung các tiêu đề  

b)   Thay đổi kích thước hiển thị dữ liệu của các trường  

c)   Thêm / bớt trường được hiển thị  

d)   Xem/ cập nhật dữ liệu cho bảng. 

Câu 13: Về thứ tự các việc cần làm với CSDL có các phương án sau : 

a)   Nhập dữ liệu → Tạo lập CSDL → Chỉnh sửa dữ liệu → Khai thác và tìm kiếm dữ liệ  

b)   Tạo lập CSDL → Nhập dữ liệu → Chỉnh sửa dữ liệu → Khai thác và tìm kiếm dữ liệu ; 

c)   Nhập dữ liệu → Chỉnh sửa dữ liệu → Tạo lập CSDL →  Khai thác và tìm kiếm dữ liệ  

d)   Các thứ tự trên đều sai. 

Câu 14: Khi tạo cấu trúc bảng cần thực hiện : 

1)   Tạo các trường           

2)   Xác định khoá chính 

3)   Lưu bảng           

4)   Nháy đúp Create table in Design view. 

Hãy cho biết thứ tự đúng thực hiện các việc trên 

a)  1 – 2 – 3 – 4      b) 2 – 1 – 4 – 3  

c)  4 – 1 – 2 – 3      d) 4 – 3 – 2 – 1  

Câu 15: Phát biểu nào sai trong các phát biểu sau ? 

a)   Để tạo đối tượng mới bắt buộc phải dùng các mẫu dựng sẵn. 

b)   Có thể dùng các mẫu dựng sẵn hoặc tự thiết kế đối tượng mới. 

c)   Dùng mẫu dựng sẵn để tạo đối tượng rồi chỉnh sửa lại bằng tự thiết kế. 

d)   Có nhiều cách để tạo đối tượng mới. 

Câu 16: Tuỳ chọn nào trong hộp thoại Find and Replace cho phép tìm những bản ghi mà 

cụm từ cần tìm phải nằm ở đầu của trường ? 

a)   Start of Field b)   Any Part of Field 

c)   Whole Field d)   Tất cả đều sai.  

Câu 17: Để tạo trường MaSo là khoá chính của bảng là trường tự động điền số ta thực 

hiện : 

a)   yêu cầu Access tự tạo ;  

b)   tạo trường MaSo có kiểu dữ liệu là AutoNumber và chỉ định làm khoá chính ; 

c)   tạo trường MaSo có kiểu dữ liệu là Number và chỉ định làm khoá chính ;  
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d)   không có cách nào tạo được. 

Câu 18: Phát biểu nào đúng trong các phát biểu sau đây khi nói về khoá chính của một 

bảng ? 

a)   Giá trị khoá chính của các hàng phải trùng nhau.  

b)   Giá trị khoá chính của các hàng phải khác nhau. 

c)   Giá trị của khoá chính có thể trùng nhau hoặc để trống.  

d)   Giá trị của khoá chính có thể trùng nhau nhưng không được để trống.  

Câu 19:  Để thêm bản ghi mới , thực hiện : 

a)   Chọn Insert → New Field b)   Chọn File → New Record 

c)   Chọn Insert → Column d)   Chọn Insert → New Record 

Câu 20: Có mấy cách lọc dữ liệu trong bảng? 

a)  Có 4 cách     b)  Có 3 cách 

c)  Có 2 cách     d)  Có 1 cách 

Câu 21: Để làm việc với biểu mẫu, ta cần nháy nút nào trên bảng chọn đối tượng. 

a)   Tables     b)   Forms 

c)   Queries     d)   Reports 

Câu 22:  Tạo biểu mẫu bằng thuật sĩ được tiến hành theo mấy bước ? 

a)   5 bước  b)   6 bước 

c)   7 bước d)   8 bước 

Câu 23: Chọn câu sai trong các câu sau : 

a)  Biểu mẫu dùng để hiển thị dữ liệu trong bảng dưới dạng thuận tiện để xem, nhập và sửa 

dữ liệu. 

b)  Ta có thể thực hiện các thao tác thông qua nút lệnh trên biểu mẫu. 

c)  Các nút lệnh trên biểu mẫu do người thiết kế tạo ra.  

d)  Các nút lệnh trên biểu mẫu là có sẵn. 

Câu 24: Dữ liệu nguồn cho biểu mẫu là :  

a)  Bảng b)  Bảng hoặc Mẫu hỏi 

c)  Mẫu hỏi               d)  Tất cả đều sai.  

Câu 25: Thuật ngữ Filter By Selection dùng để chỉ :     

a)  Lọc theo mẫu.  

b)  Lọc 

c)  Lọc theo ô dữ liệu đang chọn 

d)  Huỷ bỏ lọc  

Câu 26: Để thực hiện tìm kiếm ta chọn :    

http://www.elib.vn/


    Website: www.eLib.vn  | Facebook: eLib.vn 
 

eLib.vn: Thư viện trực tuyến miễn phí 34 

 

a)  File → Replace b)  Edit → Find 

c)  Edit → Replace d)  File → Exit. 

Câu 27: Thuật ngữ Data Type dùng để chỉ : 

a)  Trường                b)  Bản ghi 

c)  Kiểu dữ liệu d)  Tất cả đều sai. 

Câu 28: Cửa sổ cấu trúc bảng gồm có mấy phần ? 

a)   một phần  b)   2 phần 

c)   ba phần       d)   4 phần 

Câu 29: Tính chất Format (định dạng) của trường dùng để : 

a)   Quy định cách hiển thị và in dữ liệu. 

b)   Cho phép đặt kích thước cho dữ liệu lưu trong trường. 

c)   Cho phép thay tên trường bằng các phụ đề dễ hiểu với người dùng khi hiển thị. 

d)   Dùng để xác định giá tri tự động đưa vào trường khi tạo bảng ghi mới. 

Câu 30:  Để đổi tên bảng, ta chọn : 

a)   File → Save  b)   File → Rename 

c)   Edit → Copy     d)   Edit → Rename  

Câu 31:  Điều kiện lọc nào dưới đây sử dụng lọc theo ô dữ liệu đang chọn ? 

a)   Những người là nam có lương lớn hơn 2.000.000   

b)   Những người sinh năm 1980 và có địa chỉ  ở Hà Nội. 

c)   Những người có mã số lớn hơn 100   

d)   Những người sinh năm 1980. 

Câu 32:  Để mở CSDL đã có, thực hiện : 

a)   Chọn lệnh File → Open  b)   Chọn lệnh File → New 

c)   Chọn lệnh File → Save  d)   Chọn lệnh File → Exit 

ĐÁP ÁN ĐỀ KIỂM TRA 1 TIẾT TIN 12 – SỐ 8 

1B 2C 3D 4C 5A 6D 7B 8A 

9D 10C 11A 12D 13B 14C 15A 16A 

17B 18B 19D 20C 21B 22A 23D 24B 

25C 26B 27C 28B 29A 30D 31D 32A 

 

9. Đề kiểm tra 1 tiết HK1 môn Tin học 12 – Số 9 

TRƯỜNG THPT NGUYỄN THỊ MINH 

KHAI 

ĐỀ KIỂM TRA 1 TIẾT HỌC KÌ 1 

MÔN TIN HỌC 12 
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NĂM HỌC 2019-2020 

Thời gian làm bài: 45 phút 

Câu 1. Để tạo lập và khai thác một CSDL ta cần phải có :    

A. CSDL và hệ QTCSDL.                     B. Các thiết bị vật lí              

C.   A đúng và B sai                               D. A , B đều đúng 

Câu 2. Bảng đã được hiển thị ở chế độ trang dữ liệu, muốn lọc các bản ghi theo ô, sau khi 

đã chọn ô dữ liệu, ta thực hiện   thao tác. : 

A Nhấn nút                 B. Nhấn nút                    C. Nhấn nút         D. Cả B và C 

Câu 3. Khi tạo cấu trúc bảng, tên trường được nhập vào cột: 

A. Field Name                 B. Description                   C. Date Type   D.Field 

Properties 

Câu 4. Để mở một bảng đã có trên  CSDL hiện tại ta thực hiện: 

A. File/New/ Blank database.          

B. Nháy chuột vào <tên tệp>. 

C. Creat Table in Design View.       

D. File/Open/ Blank database. 

Câu 5. Để tạo  mẫu hỏi, trong cửa sổ CSDL đang làm việc ta nháy chuột vào đối tượng nào 

là đúng? 

A. Forms                B. Queries                            C. Table                 D. Report 

Câu 6. Trong cửa sổ CSDL đang làm việc, muốn dùng thuật sỹ để tạo biểu mẫu, thao tác 

nào sau đây đúng: 

A. Record/ Filter/ Filter by Form.    

B. Form/ Create Form by using Wizard/ <Chọn trường>/ Next. 

C. Record/ Filter/ Filter by Selection.       

D. Insert/ Form. 

Câu 7. Một ngân hàng thực hiện chuyển 2000000 đồng từ tài khoản A sang tài khoản B. Giả 

sử tài khoản A bị trừ 2000000 đồng nhưng số dư trong tài khoản B chưa được cộng thêm, 

thì đây vi phạm:   

A. Tính toàn vẹn.    

B. Tính độc lập                 

C. Tính nhất quán.          

D. Tính không dư thừa. 

Câu 8. Trong của sổ CSDL đang làm việc, để thiết kế một mẫu hỏi mới, ta thực hiện: 
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A. Queries/ nháy nút Design.                              B.  Queries/ Create Query by using Wizard 

C. Queries/ Create Query in Design New.          D. Cả a và c đều đúng 

Câu 9. Mỗi thư viện đều có quy định về số sách nhiều nhất mà người đọc được mượn trong 

một lần, đó là:   

A.Tính cấu trúc            B.Tính nhất quán   C. Tính không dư thừa D. Tính toàn vẹn     

Câu 10. Để sửa cấu trúc bảng, sau khi chọn tên bảng ta nhất nút: 

A.     B.                    C.                 D. Tất cả đều 

sai 

Câu 11. Các bước để tạo liên kết với bảng là: 

 (1). Tại trang bảng chọn Tool/ Relationships.         

 ( 2). Tạo liên kết đôi một giữa các bảng. 

 (3). Đóng hộp thoại Relationships/ Yes để lưu lại.        

 (4.) Chọn các bảng sẽ liên kết. 

A.   (1)->(4)-> (2)->(3)              B.  (2)-> (3)-> (4)-> (1)        

C.  (1)->(2)->(3)-> (4)              D. (4)->(2)->(3)->(1) 

Câu 12. Để lưu cấu trúc bảng mới được thiết kế, ta thực hiện thao tác: 

A. Edit/ Save/ <Tên tệp>;                  B. File/ Save/Blank Database;  

C. Edit/ Save As/ <Tên tệp>;             D. File/ Save/ <Tên tệp>; 

Câu 13. Để khởi động Access ta thực hiện: 

A. Nháy Start/ Programs/ Microsoft Access; 

B. Nháy đúp vào biểu tượng Access phía góc trái cửa sổ Access; 

C. Nháy đúp vào biểu tượng Access phía góc trái cửa sổ Access rồi chọn Open; 

D. Cả a và b đúng; 

Câu 14. Xem CSDL DIEMTHI của học sinh, phụ huynh và học sinh được quyền xem nhưng 

không được sửa. Điều này đảm bảo yêu cầu nào của CSDL: 

A. Tính cấu trúc.      B. Tính toàn vẹn.  

C. Tính nhất quán.                   D. Tính an toàn và bảo mật. 

Câu 15. Tệp CSDL trong Access có phần mở rộng là: 

A. .doc                             B. .mdb                        C. .xls                          D. .pas 

Câu 16. Câu nào đúng trong các câu dưới đây đối với khoá chính? 

A. Các giá trị của nó phải là duy nhất.   

B. Nó phải được xác định như một trường văn bản.    

C. Nó phải là trường đầu tiên của bảng. 
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D. Các giá trị của nó có thể trùng lặp 

Câu 17. Để tạo CSDL mới trong Access ta thực hiện:           

 A. Create Table In Design View                                        B. Create Table By using Wizard      

 C. File/ Open/ <Têntệp>                                                     D. File/ New/Blank Database; 

Câu 18. Khi làm việc với cấu trúc bảng, để xác định kiểu dữ liệu của trường, ta xác định tên 

kiểu dữ liệu tại cột: 

A. Field Type           B.Description               C. Data Type               D. Field Properties     

Câu 19. Để thay đổi cấu trúc của biểu mẫu, sau khi chọn tên biểu mẫu ta thực hiện: 

A. Nhấn nút                                 B. Chọn Create Form In  Design View 

C. Nhấn nút                               D. Chọn Create Form By Using Wizard  

Câu 20. Giả sử trên email có ghi : 1234@yahoo.com. Hãy cho biết trên Email có kiểu dữ 

liệu gì ? 

A. Text                     B. Currency                   C. Number                  D. AutoNumber 

Câu 21. Để thiết kế một CSDL cần phải tiếp cận theo trình tự nào? 

A. Mức vật lí - mức khung nhìn - mức khái niệm;  

B. Mức khái niệm - mức khung nhìn - mức vật lí; 

C. Mức vật lí - mức khái niệm - mức khung nhìn;  

D. Mức khung nhìn - mức khái niệm - mức vật lí; 

Câu 22. Dữ liệu kiểu Logic trong Access được ký hiệu là: 

A. Number                 B. Currency                      C. Yes/ No                 D. Autonumber 

Câu 23. Bảng đã được hiển thị ở chế độ trang dữ liệu, với một trường đã chọn, muốn sắp 

xếp các bản ghi theo thứ tự giảm dần, ta thực hiện thao tác: 

A. Nhấn nút                                               B. Record/ Sort/ Sort Ascending  

C. Create Table By Using Wizard                   D. Cả a và b đều đúng. 

Câu 24.  Một CSDL quản lý hồ sơ học sinh của một trường học có các trường như sau: STT, 

HOTEN, NGSINH, TUOI, GHICHU. Quy tắc nào bị vi phạm khi thiết kế CSDL 

A. Tính toàn vẹn         B. Tính không dư thừa              C. Tính nhất quán     D. Tính độc lập         

Câu 25. Bảng điểm thi có các trường TBHKI, TBHKII. Trong mẫu hỏi, biểu thức số học nào 

để tạo trường mới TBCN biết điểm TBCN là điểm TB của HKI và HKII với điểm TBHKII hệ 

số 2 

A. TBCN: ([TBHKI] + [TBHKII] *2)/3                B. [TBCN]: ([TBHKI] + [TBHKII] *2)/3 

C. [TBCN] = ([TBHKI] + [TBHKII] *2):3            D. TBCN = (TBHKI + TBHKII*2)/3 

Câu 26. Khi dùng thuật sỹ để tạo biểu mẫu, sau khi chọn đối tượng Form ta chọn: 
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A. Nhấn nút                                        B. Create Form By Using Wizard 

C. Create Form In  Design View             D. Cả b và c đều đúng 

Câu 27. Thành phần cơ sở của Access là 

A. Field name                          B. Record                       C. Field                     D.Table       

Câu 28. Để mở CSDL đã có ta thực hiện các thao tác: 

A. Nháy nút                                                  B. Nháy chuột lên tên của CSDL 

C. Chọn File/ Open  rồi tìm CSDL cần mở              D. Cả a và c đều đúng 

Câu 29. Có mấy chế độ làm việc với các loại đối tượng 

A. 2 chế độ                              B. 3 chế độ                       C. 4 chế độ                 D. 5 chế độ 

Câu 30. Bảng đã được hiển thị ở chế độ trang dữ liệu, muốn xóa bản ghi đã chọn, ta thực 

hiện thao tác: 

A. Nhấn phím Delete        B. Edit/ Delete Record       

C. Nhấn nút                   D. Tất cả đều đúng 

Câu 31. Một đối tượng trong Access có thể được tạo ra bằng cách: 

A. Người dùng tự thiết kế.                       B. Thiết kế, dùng  thuật sỹ hoặc kết hợp cả 2 cách     

C. Kết hợp thiết kế và thuật sỹ.                D. Dùng các mẫu dựng sẵn. 

Câu 32. Nguồn dữ liệu làm báo cáo là : 

A. bảng                                       B. Biểu mẫu                 

C. Bảng hoặc mẫu hỏi                D. Biểu mẫu hoặc mẫu hỏi  

Câu 33. Bảng điểm có các trường MOT_TIET, THI. Để tìm những HS có điểm một tiết trên 

8 và điểm thi HK trên 5, dòng Criteria của trường THI, biểu thức điều kiện nào sau đây đúng: 

A. [MOT_TIET] > “8” AND [THI] > “5”              B. MOT_TIET > 8 AND THI > 5 

C. AND ([MOT_TIET] > 8, [THI] > 5)                  D. [MOT_TIET] > 8 AND [THI] > 5 

Câu 34. Tạo mới một báo cáo: chọn đối tượng Reports trong bảng chọn đối tượng, sau đó 

chọn New, tiếp đến phải chọn chế độ nào trong các chế độ đưa ra dưới đây để có một báo 

cáo theo ý người sử dụng: 

A. Design View              B. Report Wizard             C. Chart Wizard          D. Label Wizard 

Câu 35. Đâu không phải là chế độ làm việc với các đối tượng trong Access? 

A. Chế độ thiết kế                                  B. Chế độ trang dữ liệu     

C. Chế độ mã hóa bằng câu lệnh            D. Chế độ biểu mẫu 

Câu 36. Bảng đã được hiển thị ở chế độ trang dữ liệu, muốn thêm bản ghi, ta thực hiện thao 

tác: 

A. Insert/ New Record                 B. Nhấn nút      
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C. Edit/ Insert/ Rows                  D. Cả a và b đều đúng 

Câu 37. Bảng đã được hiển thị ở chế độ trang dữ liệu, muốn lọc các bản ghi theo mẫu, ta 

thực hiện thao tác: 

A. Record/ Filter/ Filter By Selection                 C. Nhấn nút   

B. Record/ Filter/ Filter By Form                        D. Nhấn nút   

Câu 38. Vai trò của người QTCSDL 

A. Bảo trì hệ CSDL                    B. Nâng cấp hệ CSDL           

C. Tổ chức hệ thống                   D. Cả A,B và C. 

Câu 39. Bảng đã được hiển thị ở chế độ thiết kế, muốn thêm một trường vào bên trên trường 

hiện tại, ta thực hiện thao tác: 

A. Insert/ Column                       B. Insert/ Rows     

C. File/Insert/ <tên tệp>              D. File/ New/ Blank Database.    

Câu 40. Liên kết các bảng nhằm mục đích 

A. Để có được thông tin tổng hợp từ nhiều bảng mà các yêu cầu của hệ CSDL vẫn được 

đảm bảo 

B. Tránh việc dư thừa dữ liệu 

C. Đảm bảo tính an toàn và bảo mật thông tin 

D. Cả B và C 

ĐÁP ÁN ĐỀ KIỂM TRA 1 TIẾT TIN 12 – SỐ 9 

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 

D A A B B B C C D B A D A D B A D C C A 

21 22 23 24 25 26 27 28 29 30 31 32 33 34 35 36 37 38 39 40 

D C A B A B D C A D B C D A C D B D B D 

 

10. Đề kiểm tra 1 tiết HK1 môn Tin học 12 – Số 10 

TRƯỜNG THPT HƯƠNG KHÊ ĐỀ KIỂM TRA 1 TIẾT HỌC KÌ 1 

MÔN TIN HỌC 12 

NĂM HỌC 2019-2020 

Thời gian làm bài: 45 phút 

Câu 1. Thành phần cơ sở của Access là 

A. Table                  B. Field name                          C. Record                       D. Field                      

Câu 2. Một đối tượng trong Access có thể được tạo ra bằng cách: 

A. Người dùng tự thiết kế.                       B. Thiết kế, dùng  thuật sỹ hoặc kết hợp cả 2 cách     
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C. Kết hợp thiết kế và thuật sỹ.                D. Dùng các mẫu dựng sẵn. 

Câu 3. Có mấy chế độ làm việc với các loại đối tượng 

A. 5 chế độ                              B. 3 chế độ                       C. 4 chế độ                 D. 2 chế độ 

Câu 4. Bảng đã được hiển thị ở chế độ trang dữ liệu, với một trường đã chọn, muốn sắp xếp 

các bản ghi theo thứ tự giảm dần, ta thực hiện thao tác: 

A. Create Table By Using Wizard                          

B. Record/ Sort/ Sort Ascending  

C. Nhấn nút                                                        

D. Cả a và b đều đúng. 

Câu 5. Bảng điểm có các trường MOT_TIET, THI. Để tìm những HS có điểm một tiết trên 8 

và điểm thi HK trên 5, dòng Criteria của trường THI, biểu thức điều kiện nào sau đây đúng: 

A. [MOT_TIET] > “8” AND [THI] > “5”                

B. MOT_TIET > 8 AND THI > 5 

C. AND ([MOT_TIET] > 8, [THI] > 5)                    

D. [MOT_TIET] > 8 AND [THI] > 5 

Câu 6. Đâu không phải là chế độ làm việc với các đối tượng trong Access? 

A. Chế độ thiết kế                                   B. Chế độ trang dữ liệu     

C. Chế độ mã hóa bằng câu lệnh            D. Chế độ biểu mẫu 

Câu 7. Để thiết kế một CSDL cần phải tiếp cận theo trình tự nào? 

A. Mức khung nhìn - mức khái niệm - mức vật lí ; 

B. Mức vật lí - mức khung nhìn - mức khái niệm;  

C. Mức khái niệm - mức khung nhìn - mức vật lí; 

D. Mức vật lí - mức khái niệm - mức khung nhìn;  

Câu 8. Bảng điểm thi có các trường TBHKI, TBHKII. Trong mẫu hỏi, biểu thức số học nào 

để tạo trường mới TBCN biết điểm TBCN là điểm TB của HKI và HKII với điểm TBHKII hệ 

số 2 

A. TBCN: ([TBHKI] + [TBHKII] *2)/3                B. [TBCN]: ([TBHKI] + [TBHKII] *2)/3 

C. [TBCN] = ([TBHKI] + [TBHKII] *2):3            D. TBCN = (TBHKI + TBHKII*2)/3 

Câu 9. Để tạo lập và khai thác một CSDL ta cần phải có :    

A. CSDL và hệ QTCSDL.                     B. Các thiết bị vật lí              

C.   A đúng và B sai                               D. A , B đều đúng 

Câu 10. Khi tạo cấu trúc bảng, tên trường được nhập vào cột: 
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A. Description                 B. Date Type               C. Field Name              D.Field 

Properties 

Câu 11. Để tạo  mẫu hỏi, trong cửa sổ CSDL đang làm việc ta nháy chuột vào đối tượng nào 

là đúng? 

A. Forms                B. Queries                            C. Table                 D. Report 

Câu 12. Mỗi thư viện đều có quy định về số sách nhiều nhất mà người đọc được mượn trong 

một lần, đó là:   

A.Tính cấu trúc            B.Tính nhất quán   C. Tính không dư thừa D. Tính toàn vẹn     

Câu 13. Một ngân hàng thực hiện chuyển 2000000 đồng từ tài khoản A sang tài khoản B . 

Giả sử tài khoản A bị trừ 2000000 đồng nhưng số dư trong tài khoản B chưa được cộng 

thêm , thì đây vi phạm:   

A. Tính toàn vẹn.    

B. Tính độc lập                 

C. Tính nhất quán .          

D. Tính không dư thừa . 

Câu 14. Các bước để tạo liên kết với bảng là: 

 (1). Tại trang bảng chọn Tool/ Relationships. 

 (2.) Chọn các bảng sẽ liên kết. 

 ( 3). Tạo liên kết đôi một giữa các bảng. 

 (4). Đóng hộp thoại Relationships/ Yes để lưu lại.         

A.   (1)->(4)-> (2)->(3)              B.  (2)-> (3)-> (4)-> (1)        

C.  (1)->(2)->(3)-> (4)              D. (4)->(2)->(3)->(1) 

Câu 15. Để khởi động Access ta thực hiện: 

A. Nháy Start/ Programs/ Microsoft Access; 

B. Nháy đúp vào biểu tượng Access phía góc trái cửa sổ Access; 

C. Nháy đúp vào biểu tượng Access phía góc trái cửa sổ Access rồi chọn Open; 

D. Cả a và b đúng; 

Câu 16. Để thay đổi cấu trúc của biểu mẫu, sau khi chọn tên biểu mẫu ta thực hiện: 

A. Nhấn nút                                 B. Chọn Create Form In  Design View 

C. Nhấn nút                               D. Chọn Create Form By Using Wizard  

Câu 17. Tệp CSDL trong Access có phần mở rộng là: 

A. .doc                             B. .mdb                        C. .xls                          D. .pas 

Câu 18. Để tạo CSDL mới trong Access ta thực hiện:           
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 A. Create Table In Design View                                        B. Create Table By using Wizard      

 C. File/ Open/ <Têntệp>                                                     D. File/ New/Blank Database; 

Câu 19. Bảng đã được hiển thị ở chế độ thiết kế, muốn thêm một trường vào bên trên trường 

hiện tại, ta thực hiện thao tác: 

A. Insert/ Column                       B. Insert/ Rows     

C. File/Insert/ <tên tệp>              D. File/ New/ Blank Database.    

Câu 20. Bảng đã được hiển thị ở chế độ trang dữ liệu, muốn lọc các bản ghi theo mẫu, ta 

thực hiện thao tác: 

A. Record/ Filter/ Filter By Form                                        C. Nhấn nút   

B. Record/ Filter/ Filter By Selection                                  D. Nhấn nút   

Câu 21. Bảng đã được hiển thị ở chế độ trang dữ liệu, muốn lọc các bản ghi theo ô, sau khi 

đã chọn ô dữ liệu, ta thực hiện   thao tác. : 

A. Nhấn nút              B Nhấn nút                     C. Nhấn nút          D. Cả B và C 

Câu 22. Để mở một bảng đã có trên  CSDL hiện tại ta thực hiện: 

A. File/New/ Blank database.         C. Nháy chuột vào <tên tệp>. 

B. Creat Table in Design View.      D. File/Open/ Blank database. 

Câu 23. Trong cửa sổ CSDL đang làm việc, muốn dùng thuật sỹ để tạo biểu mẫu, thao tác 

nào sau đây đúng: 

A. Record/ Filter/ Filter by Form.    

B. Form/ Create Form by using Wizard/ <Chọn trường>/ Next. 

C. Record/ Filter/ Filter by Selection.       

D. Insert/ Form. 

Câu 24. Liên kết các bảng nhằm mục đích 

A. Để có được thông tin tổng hợp từ nhiều bảng mà các yêu cầu của hệ CSDL vẫn được 

đảm bảo 

B. Tránh việc dư thừa dữ liệu 

C. Đảm bảo tính an toàn và bảo mật thông tin 

D. Cả B và C 

Câu 25. Vai trò của người QTCSDL 

A. Bảo trì hệ CSDL                    B. Nâng cấp hệ CSDL           

C. Tổ chức hệ thống                   D. Cả A,B và C. 

Câu 26. Trong của sổ CSDL đang làm việc, để thiết kế một mẫu hỏi mới, ta thực hiện: 

A. Queries/ nháy nút Design.                              B.  Queries/ Create Query by using Wizard 
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C. Queries/ Create Query in Design New.          D. Cả a và c đều đúng. 

Câu 27. Bảng đã được hiển thị ở chế độ trang dữ liệu, muốn thêm bản ghi, ta thực hiện thao 

tác: 

A. Insert/ New Record                 B. Nhấn nút      

C. Edit/ Insert/ Rows                  D. Cả a và b đều đúng 

Câu 28.  Để sửa cấu trúc bảng, sau khi chọn tên bảng ta nhất nút: 

A.                     B.            C.       D. Tất cả đều 

sai 

Câu 29. Xem CSDL   DIEMTHI của học sinh, phụ huynh và học sinh được quyền xem nhưng 

không được sửa. Điều này đảm bảo yêu cầu nào của CSDL: 

A. Tính cấu trúc.     B. Tính an toàn và bảo mật. 

C. Tính nhất quán.                D. Tính toàn vẹn.  

Câu 30. Để lưu cấu trúc bảng mới được thiết kế, ta thực hiện thao tác: 

A. Edit/ Save/ <Tên tệp>;                  B. File/ Save/Blank Database;  

C. Edit/ Save As/ <Tên tệp>;             D. File/ Save/ <Tên tệp>; 

Câu 33.  Câu nào đúng trong các câu dưới đây đối với khoá chính? 

A. Các giá trị của nó phải là duy nhất.   C. Nó phải là trường đầu tiên của bảng. 

B. Nó phải được xác định như một trường văn bản.      D. Các giá trị của nó có thể trùng 

lặp 

Câu 34. Dữ liệu kiểu Logic trong Access được ký hiệu là: 

A. Number                 B. Currency                      C. Yes/ No                 D. Autonumber 

Câu 35.  Một CSDL quản lý hồ sơ học sinh của một trường học có các trường như sau: STT, 

HOTEN, NGSINH, TUOI, GHICHU. Quy tắc nào bị vi phạm khi thiết kế CSDL 

A. Tính toàn vẹn         B. Tính không dư thừa              C. Tính nhất quán     D. Tính độc lập         

Câu 36. Khi dùng thuật sỹ để tạo biểu mẫu, sau khi chọn đối tượng Form ta chọn: 

A. Nhấn nút                                        B. Create Form By Using Wizard 

C. Create Form In  Design View             D. Cả b và c đều đúng 

Câu 37. Để mở CSDL đã có ta thực hiện các thao tác: 

A. Nháy nút                                                  B. Nháy chuột lên tên của CSDL 

C. Chọn File/ Open  rồi tìm CSDL cần mở              D. Cả a và c đều đúng 

Câu 38. Bảng đã được hiển thị ở chế độ trang dữ liệu, muốn xóa bản ghi đã chọn, ta thực 

hiện thao tác: 

A. Nhấn phím Delete        B. Edit/ Delete Record       
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C. Nhấn nút                   D. Tất cả đều đúng 

Câu 39. Tạo mới một báo cáo: chọn đối tượng Reports trong bảng chọn đối tượng, sau đó 

chọn New, tiếp đến phải chọn chế độ nào trong các chế độ đưa ra dưới đây để có một báo 

cáo theo ý người sử dụng: 

A. Design View              B. Report Wizard             C. Chart Wizard          D. Label Wizard 

Câu 40. Nguồn dữ liệu làm báo cáo là : 

A. bảng                                      

B. Biểu mẫu                 

C. Bảng hoặc mẫu hỏi                 

D. Biểu mẫu hoặc mẫu hỏi  

 

ĐÁP ÁN ĐỀ KIỂM TRA 1 TIẾT TIN 12 – SỐ 10 

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 

A B D C D C A A D C B D C C A C B D B A 

21 22 23 24 25 26 27 28 29 30 31 32 33 34 35 36 37 38 39 40 

B C B D D C D A B D C A A C B B C D A C 
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